zenon manual
zenon WPF-Element

v.7.60
# Table of contents

1. Welcome to COPA-DATA help ......................................................................................................................... 5

2. WPF element .................................................................................................................................................. 5

3. Basics ........................................................................................................................................................... 6
   3.1 WPF in process visualization ....................................................................................................................... 6
   3.2 Referenced assemblies ................................................................................................................................. 8
   3.3 Workflows ................................................................................................................................................... 9
      3.3.1 Workflow with Microsoft Expression Blend ......................................................................................... 10
      3.3.2 Workflow with Adobe Illustrator ......................................................................................................... 10

4. Guidelines for designers ............................................................................................................................... 10
   4.1 Workflow with Microsoft Expression Blend ............................................................................................ 11
      4.1.1 Create button as an XAML file with Microsoft Expression Blend ..................................................... 11
   4.2 Workflow with Adobe Illustrator .............................................................................................................. 15
      4.2.1 Bar graph illustration ......................................................................................................................... 16
      4.2.2 WPF export ....................................................................................................................................... 18
      4.2.3 Animation in Blend .............................................................................................................................. 19

5. Guidelines for developers .............................................................................................................................. 23
   5.1 Creation of a simple WPF user control with code behind function ......................................................... 23
   5.2 Debugging the WPF user control in Runtime ........................................................................................... 29
   5.3 Data exchange between zenon and WPF user controls ............................................................................ 33
      5.3.1 Data exchange using dependency properties ...................................................................................... 34
      5.3.2 Data replacement via VSTA .................................................................................................................. 37
   5.4 Access to the zenon (Runtime) object model from a WPF user control ................................................... 39
      5.4.1 Access via VSTA "variable link" .......................................................................................................... 39
      5.4.2 Access via marshaling ......................................................................................................................... 43

6. Engineering in zenon ................................................................................................................................... 47
   6.1 CDWP files (collective files) ..................................................................................................................... 47
   6.2 create WPF element ................................................................................................................................ 48
   6.3 Configuration of the linking ....................................................................................................................... 49
      6.3.1 Properties .......................................................................................................................................... 51
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.3.2</td>
<td>Events</td>
<td>57</td>
</tr>
<tr>
<td>6.3.3</td>
<td>Transformation</td>
<td>58</td>
</tr>
<tr>
<td>6.4</td>
<td>Validity of XAML Files</td>
<td>61</td>
</tr>
<tr>
<td>6.5</td>
<td>Pre-built elements</td>
<td>63</td>
</tr>
<tr>
<td>6.5.1</td>
<td>Analog clock - AnalogClockControl</td>
<td>64</td>
</tr>
<tr>
<td>6.5.2</td>
<td>Bar graph vertical - VerticalBargraphControl</td>
<td>65</td>
</tr>
<tr>
<td>6.5.3</td>
<td>Progress bar - ProgressBarControl</td>
<td>66</td>
</tr>
<tr>
<td>6.5.4</td>
<td>COMTRADE-Viewer</td>
<td>66</td>
</tr>
<tr>
<td>6.5.5</td>
<td>Energy class diagram</td>
<td>77</td>
</tr>
<tr>
<td>6.5.6</td>
<td>Pareto diagram</td>
<td>78</td>
</tr>
<tr>
<td>6.5.7</td>
<td>Circular gauge control</td>
<td>82</td>
</tr>
<tr>
<td>6.5.8</td>
<td>Sankey diagram</td>
<td>85</td>
</tr>
<tr>
<td>6.5.9</td>
<td>Temperature indicator - TemperatureIndicatorControl</td>
<td>87</td>
</tr>
<tr>
<td>6.5.10</td>
<td>Universal slider - UniversalReglerControl</td>
<td>88</td>
</tr>
<tr>
<td>6.5.11</td>
<td>Waterfall diagram</td>
<td>89</td>
</tr>
<tr>
<td>6.6</td>
<td>Display of WPF elements in the zenon web client</td>
<td>90</td>
</tr>
<tr>
<td>6.6.1</td>
<td>Engineering in the zenon Editor</td>
<td>91</td>
</tr>
<tr>
<td>6.6.2</td>
<td>VSTA code (complex)</td>
<td>91</td>
</tr>
<tr>
<td>6.6.3</td>
<td>VSTA code (simplified)</td>
<td>93</td>
</tr>
<tr>
<td>6.7</td>
<td>Examples: Integration of WPF in zenon</td>
<td>94</td>
</tr>
<tr>
<td>6.7.1</td>
<td>Integrate bar graph as WPF XAML in zenon</td>
<td>94</td>
</tr>
<tr>
<td>6.7.2</td>
<td>Integrate button as WPF XAML in zenon</td>
<td>100</td>
</tr>
<tr>
<td>6.7.3</td>
<td>Integrate DataGrid Control in zenon</td>
<td>106</td>
</tr>
<tr>
<td>6.8</td>
<td>Error handling</td>
<td>113</td>
</tr>
</tbody>
</table>
1. Welcome to COPA-DATA help

GENERAL HELP

If you cannot find any information you require in this help chapter or can think of anything that you would like added, please send an email to documentation@copadata.com (mailto:documentation@copadata.com).

PROJECT SUPPORT

You can receive support for any real project you may have from our Support Team, who you can contact via email at support@copadata.com (mailto:support@copadata.com).

LICENSES AND MODULES

If you find that you need other modules or licenses, our staff will be happy to help you. Email sales@copadata.com (mailto:sales@copadata.com).

2. WPF element

With the WPF dynamic element, valid WPF/XAML files in zenon can be integrated and displayed.

Information

All brand and product names in this documentation are trademarks or registered trademarks of the respective title holder.
3. Basics

XAML

XAML stands for Extensible Application Markup Language. The XML-based descriptive text developed by Microsoft defines graphic elements, animations, transformations, displays of color gradients etc. in Silverlight and WPF user interfaces. The use of XAML makes it possible to strictly separate design and programming. The designer prepares, for example, the graphical user interface and creates basic animations that are then used by the developers/project planners who create the application logic.

WPF

WPF stands for Windows Presentation Foundation and describes a graphics framework that is part of the Windows .NET framework:

- WPF provides a comprehensive model for the programmer.
- XAML describes, based on XML, the interface hierarchy as a markup language. Depending on the construction of the XAML file, there is the possibility to link properties, events and transformations of WPF elements with variables and functions of CD_PRODUCTNAME<.
- The framework unites the different areas of presentation such as user interface, drawing, graphics, audio, video, documents and typography.

For execution in zenon, Microsoft .NET framework version 3.5 or higher is required.

3.1 WPF in process visualization

XAML makes different design possibilities possible for zenon. Display elements and dynamic elements can be adapted graphically regardless of the project planning. For example, laborious illustrations are first created by designers and then imported into zenon as an XAML file and linked to the desired logic. There are many possibilities for using this, for example:

DYNAMIC ELEMENTS IN ANALOG-LOOK

Graphics no longer need to be drawn in zenon, but can be imported directly as an XAML file. This makes it possible to use complex, elaborately illustrated elements in process visualization. Reflections, shading,
3D effects etc. are supported as graphics. The elements that are adapted to the respective industry environment make intuitive operation possible, along the lines of the operating elements of the machine.

**INTRICATE ILLUSTRATIONS FOR INTUITIVE OPERATION**

The integration of XAML-based display elements improves the graphics of projects and makes it very easy to display processes clearly. Elements optimized for usability make operation easier. A clear display of data makes it easier to receive complex content. The flexible options for adapting individual elements makes it easier to use for the operator. It is therefore possible for the project planners to determine display values, scales and units on their own.

**CLEAR PRESENTATION OF DATA AND SUMMARIES**

Grouped display elements make it possible to clearly display the most important process data, so that the equipment operator is always informed of the current process workflow. Graphical evaluations, display values and sliders can be grouped into an element and make quick and uncomplicated control possible.

**INDUSTRY-SPECIFIC DISPLAYS**

Elements such as thermometers, scales or bar graphs are part of the basic elements of process visualization. It is possible, using XAML, to adapt these to the respective industry. Thus equipment operators can find the established and usual elements that they already know from the machines in process visualization at the terminal.

**ADAPTATION TO CORPORATE DESIGN**

Illustrations can be adapted to the respective style requirements of the company, in order to achieve a consistent appearance through to the individual process screen. For example, the standard operation
elements from zenon can be used, which can then be adapted to color worlds, house fonts and illustration styles of the corporate design.

3.2 Referenced assemblies

It is not just standard objects (rectangles, graphics, etc.) or effects (color gradients, animations, etc.) that can be displayed using the WPF elements, but also customized user controls (with logic in the code behind), which are referenced as assemblies.

For example, a user control that looks like a tacho and provides special properties and optical effects can be created, such as a "Value" property, which causes the pointer of the tacho to move and/or the corresponding value to be displayed in a label.

The workflow for this:

- The appearance of a user controls is labeled with standard objects, which are offered by WPF.
- The properties and interactions are programmed.
- The whole package is compiled and present in the form of a .NET assembly.

This assembly can also be used for WPF projects. To do this, it must be referenced (linked) in the WPF editor (for example: Microsoft Expression Blend). To do this, select the assembly in the zenon file selection dialog:

![Image of reference dialog]

From this point in time, the WPF user controls of the assembly in the tool box can be selected under Custom user controls and used in the WPF project.

See also, in relation to this, the following chapter: Guidelines for developers (on page 23).

**USED REFERENCED ASSEMBLIES IN ZENON**

To use an assembly in zenon, this must be provided as a file. Collective files in .cdwpf format administer these independently; no further configuration is necessary. Assemblies must be added to the Files folder for .xaml files:

- Click on Files on the project tree
- Select Other
- Select Add file... in the context menu
- The configuration dialog opens
- Insert the desired assembly
When displaying a WPF file in the **WPF element** (Editor and Runtime), the assemblies from this folder are loaded. It is thus also ensured that that when the Runtime files are transferred using **Remote Transport**, all referenced assemblies are present on the target computer.

A collective file (**.cdwpf**) can exist alongside an XAML file with the same name. All assemblies (***.dll** from all collective files and the **Other** folder are copied to the work folder. Only the highest file version is used if there are several assemblies with the same name.

**Attention**

*Assemblies are only removed after loading when the application is ended. This means:*

*If a WPF file with a referenced assembly in zenon is displayed, then this assembly is loaded is in the memory until zenon is ended, even if the screen is closed again. If you would like to remove an assembly from the Files/Other folder, the Editor must first be restarted, so that the assembly is removed.*

**MULTI-PROJECT ADMINISTRATION**

*With multi-project administration, the same assembly must be used in all projects. If an assembly is replaced by another version in a project, it must also be replaced in all other projects that are loaded in the Editor or in Runtime.*

### 3.3 Workflows

The WPF/XAML technology makes new workflows in process visualization possible. The separation of design and functionality ensures a clear distinction of roles between the project engineer and designers; design tasks can be easily fulfilled by using pre-existing designs, which no longer need to be modified by the project engineer.

The following people are involved in the workflow to create WPF elements in zenon:

- **Designer**
  - illustrates elements
  - takes care of the graphics for MS Expression Design
- **MS Expression Blend operator**
  - Animates elements
  - Creates variables for the animation of WPF elements in zenon, which project engineer can access
- **Project engineer**
  - Integrates elements into zenon:
  - stores logic and functionality
We make a distinction:

- Workflow with Microsoft Expression Blend (on page 10)
- Workflow with Adobe Illustrator (on page 10)

### 3.3.1 Workflow with Microsoft Expression Blend

When using Microsoft Expression Blend, a WPF element is created in four stages:

1. Illustration of elements in **MS Expression Blend** (on page 11)
2. Open element in **MS Expression Design** and export as WPF
3. Animation in **MS Expression Blend** (on page 11)
4. Integration into zenon (on page 100)

You can find an example for creating a WPF elements with Microsoft Expression Blend in the Create button as XAML file with Microsoft Expression Blend (on page 11) chapter.

### 3.3.2 Workflow with Adobe Illustrator

Based on traditional design processes with **Adobe Illustrator** the following workflow is available:

1. Illustration of elements in **Adobe Illustrator** (on page 16)
2. Import of .ai files and preparation in **MS Expression Design** (on page 18)
3. WPF export from **MS Expression Design** (on page 18)
4. Animation in **MS Expression Blend** (on page 19)
5. Integration into zenon (on page 94)

You can find an example for creation in the Workflow with Adobe Illustrator (on page 15) chapter.

### 4. Guidelines for designers

This section informs you how to correctly create WPF files in Microsoft Expression Blend and Adobe Illustrator. The tutorials on Creating a button element (on page 11) and a bar graph element (on page 15) show you how fully functional WPF files for zenon can be created from pre-existing graphics in a few steps.
The following tools were used for this:

- Adobe Illustrator CS3 (AI)
- Microsoft Expression Design 4 (ED)
- Microsoft Expression Blend 4 (EB)
- zenon

Information

If referenced objects (assemblies) are used in WPF, note the instructions in the Referenced objects (on page 8) chapter.

4.1 Workflow with Microsoft Expression Blend

With Microsoft Expression Blend, a WPF element:

- is illustrated
- is converted into WPF format using MS Expression Design
- animated

The following example shows the illustration and conversion of a button element into an XAML file.

Note: A test version of "Microsoft Expression Blend" can be downloaded from the Microsoft website.

4.1.1 Create button as an XAML file with Microsoft Expression Blend

CREATE BUTTON

1. Start Expression Blend
2. select the **New Project** option

![New Project Dialog]

3. **Select WPF** as project type

4. **give it a path and name of your choice (MyBlendProject, for example)**

![New Project Window]

The **Language** and **Version** settings can be ignored, because no functionality is to be programmed.

5. **After the dialog has been confirmed with OK**, Microsoft Blend creates a new project with the chosen settings. Expression Blend adds an empty XAML file which already contains a class reference.

6. **Delete the CS file that belongs to the XAML file using the context menu.**
7. Rename the XAML file `MainControl.xaml` to `MyButton.xaml`.

8. The development size of the file is set at 640 x 480 pixels as standard and must still be changed:
   a) switch to **XAML** view
   b) correct the size to 100 x 100 pixels
   c) Delete the class reference `x:Class="MyBlendProject.MyButton"

```
x:Class="MyButton"  
<Grid x:Name="layoutRoot" />  
</UserControl>
```

9. switch to **Design** view

10. add a button via the toolbar

11. define the properties
   - Width: 50
   - Height: 50
Morins: 25

The button is therefore at the center of the control.

12. Save the changes and open the file in Internet Explorer to check it. You will see that the button is displayed in a size of 50 x 50 pixels.

MAKE BUTTON SCALABLE

If you integrate this status into zenon, the button will always have the exact size of 50 x 50 pixels. Because the button can be implemented as a scalable button, switch to Expression Blend again:

1. select the button in the tree view
2. select the Group Into->Viewbox button in the context menu
3. the button is inserted into a Viewbox
4. Define the properties of the viewbox
   - Width: Auto
   - Height: Auto
5. save the file

6. If you now open the file in Internet Explorer, the button is automatically scaled when the IE window size is changed. This file will now also automatically adapt to changes in the size of the WPF element in zenon.

CHANGE NAME

Before you can integrate the file into zenon, you must give the WPF element a name. The WPF elements are not named in Expression Blend as standard, and are labeled with square brackets and their type. zenon content is assigned to WPF content via the name of the WPF elements:

- in tree view, change the name
  - of the button on MyButton
  - of the ViewBox to MyViewBox

This button can now be integrated in zenon (on page 100) as an XAML file.

4.2 Workflow with Adobe Illustrator

When Adobe Illustrator is used, a WPF element:

- is illustrated in Adobe Illustrator
- is converted into a WPF in MS Expression Design
- is animated in MS Expression Blend

The following example shows the illustration and conversion of a bar graph element into an XAML file.
4.2.1 Bar graph illustration

A bar graph is created in Adobe Illustrator.

1. **AI: Starting element for bar graph**

Illustrated in Adobe Illustrator CS3.

2. **AI: Path view of bar graph in Adobe Illustrator**

- All effects must be converted (Object -> Convert appearance)
- All lines are transformed into paths (Object -> Path -> Contour line)
- Do not use filters such as shading, blurring etc.

**NOTES ON COMPATIBILITY**

Illustrations that were created with Adobe Illustrator are in principle suitable for WPF export. However, not all Illustrator effects can become corresponding effects in Expression Design/Blend. Note:
<table>
<thead>
<tr>
<th>Effect</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Clipping masks</strong></td>
<td>Clipping masks created in Adobe Illustrator are not correctly interpreted by Expression Design. These are usually shown in Blend as areas of black color. We recommend creating illustrations without clipping masks.</td>
</tr>
<tr>
<td><strong>Filters and effects</strong></td>
<td>Not all Adobe Illustrator filters are transferred into Expression Design accordingly: Thus blurring filters, shading filters and corner effects from Illustrator do not work in Expression Design.</td>
</tr>
<tr>
<td><strong>Solution:</strong></td>
<td>• Most effects can be converted so that they can be read correctly by Expression Design using the <strong>Object -&gt; Convert appearance</strong> command in Adobe Illustrator.</td>
</tr>
<tr>
<td></td>
<td>• Corner effects from Adobe Illustrator are correctly interpreted by MS Design if they are converted to AI in paths.</td>
</tr>
<tr>
<td><strong>Text fields</strong></td>
<td>To be able to link text fields with code, these must be created separately in Expression Blend. <strong>&quot;Labels&quot;</strong> are required for dynamic texts; simple <strong>&quot;text fields&quot;</strong> are sufficient for static information.</td>
</tr>
<tr>
<td></td>
<td>There is no possibility to create text labels in MS Design. These must be directly created in MS Blend.</td>
</tr>
<tr>
<td><strong>Transparencies and group transparencies</strong></td>
<td>There can be difficulties in Adobe Illustrator with the correct interpretation of transparency settings, in particular from group transparency settings.</td>
</tr>
<tr>
<td></td>
<td>However MS Expression Blend and MS Expression Design do offer the possibility to create new transparency settings.</td>
</tr>
<tr>
<td><strong>Multiply levels</strong></td>
<td>These level settings in Adobe Illustrator are not always correctly displayed by MS Expression Blend.</td>
</tr>
<tr>
<td></td>
<td>However, there is the possibility to <strong>&quot;Multiply levels&quot;</strong> directly in Expression Design.</td>
</tr>
</tbody>
</table>
| **Indicating instruments and standard positions** | To prepare the graphics optimally for animation, the indicator and slider must always be set to the starting position, usually 0 or 12:00 o'clock.  

Thus the position parameters for rotations etc. are also correct in Blend and an animation can be implemented without conversion of position data.  |
4.2.2 WPF export

WPF files are required for animation in Microsoft Expression Blend. We recommend Microsoft Expression Design for this export, because it provides good results and most Illustrator effects are correctly interpreted.

**Note:** There is a free plug-in for the direct export of WPF files from Adobe Illustrator available on the internet. This plug-in provides a quick, uncomplicated way of exporting from Illustrator, however it is less suited to the current application because it lead to graphical losses. Even color deviations from the original document are possible.

Files in .ai format can regularly be imported into Expression Design; the paths are retained in the process.

**Attention:** Some common Illustrator effects cannot be displayed by Expression Design correctly however (see Illustration (on page 16) chapter).

We export the pre-created bar graph element in 5 stages:

1. **ED: Import**
   - Import the prepared Illustrator file (on page 16) in Microsoft Expression Design via *File -> Import*

2. **ED: Optimization**
   - If the starting file is not correctly displayed in MS Expression Design, it can still be subsequently edited and optimized here
3. **ED: Select**

   - Highlight the element for WPF export with the **direct selection** arrow in MS Expression Design; in this case it is the whole clock

4. **ED: Start export**

   - Start the export via *File -> Export*
   - the dialog for configuring the export settings opens

5. **ED: Export settings**

   - Enter the following export settings:
   a) **Format:** XAML Silverlight 4 / WPF Canvas
      - **Always name objects:** Activate with tick
      - **Place the grouped object in an XAML layout container:** Activate with tick
   b) **Text:** Editable text block
   c) **Line effects:** Rasterize all

The exported file has `.xaml` file suffix. It is prepared and animated (on page 19) in MS Expression Blend in the next stage.

### 4.2.3 Animation in Blend

With MS Expression Blend:
- static XAML files from MS Expression Design are animated
- Variables for controlling effects that can be addressed by zenon are created
In thirteen steps, we go from a static XAML to an animated element, that can be embedded in zenon:

1. **EB: create project**
   - a) Open Microsoft Expression Blend
   - b) Create a new project
   - c) Select the **Project type** of *WPF-Control Library*
   - d) Give it a name (in our tutorial: **My_Project**)
   - e) Select a location where it is to be saved
   - f) Select a language (in our tutorial: **C#**)
   - g) Select Framework Version 3.5

2. **EB: delete MainControl.xaml.cs**
   - a) Navigate to **MainControl.xaml.cs**
   - b) Delete this file using the **Delete** command in the context menu

3. **EB: Open exported XAML file**
   - a) Open the context menu for **My_Project** (right mouse button)
   - b) Select **Add existing element...**
   - c) Select the XAML file exported from Microsoft Expression Design, in order to open this in Microsoft Expression Blend

4. **EB: Open MainControl.xaml**
a) Open the automatically created `MainControl.xaml`

b) In the **Objects and Time axes** area, navigate to the **UserControl** entry

5. **EB: Adapt XAML code**

   a) Click on **UserControl** with the right mouse button

   b) Select **Display XAML** in the contextual menu.

   c) Delete lines 7 and 9 in the XAML code:

   ```xml
   x:Class="My_Project.MainControl"
   d:DesignWidth="640" d:DesignHeight="480"
   ```

6. **EB: check XAML code**

   - The XAML code should now look like this:

   ```xml
   <UserControl
      xmlns=http://schemas.microsoft.com/winfx/2006/xaml/presentation
      xmlns:x=http://schemas.microsoft.com/winfx/2006/xaml

      mc:Ignorable="d"
      x:Name="UserControl">
      <Grid x:Name="LayoutRoot"/>
   </UserControl>
   ```

7. **EB: Copy elements**

   a) Open the XAML file imported from Expression Design

   b) Mark all elements

   c) Select **Delete** in the context menu

   d) Change back to the automatically created XAML file
8. **EB: Insert element**
   
   a) Click on **Layout Root** with the right mouse button
   b) Select **Insert**

9. **EB: Adapt layout type**
   
   a) Click on **Layout root -> Change layout type -> Viewbox** with the right mouse button
   b) The structure should now look like this: **UserControl -> LayoutRoot -> Grid -> Elements**
   c) Give a name for **LayoutRoot** and **Grid** by double-clicking on the names

10. **EB: Texts and values**

   - Dynamic and static texts are labeled with text fields
   - Values (numbers) are issued with **Labels**

11. **EB: Insert labels**

   - Labels replace numbers that are to be subsequently linked using INT variables (must be carried out for all number elements)

12. **EB: Set property**

   - To display 100%, set the bar graph element’s **MaxHeight** property to 341 (the maximum height of the indicator element is 340)
13. **EB: prepare for use in zenon**

   a) Delete all name labels (names may only be given for elements that are to be addressed via zenon)
   b) Save the XAML file with any desired name
   c) Integrate the XAML file into zenon (on page 94)

   **A tip for checking:** If the XAML file is displayed with no problems in Microsoft Internet Explorer and the window size of Internet Explorer adapts to it, it will also be correctly used in zenon.

5. **Guidelines for developers**

   This section handles the creation of simple WPF user controls with code-behind functionality using Microsoft Visual Studio and debugging this user control in Runtime.

   The following tools were used for this:
   - Microsoft Visual Studio 2015
   - zenon

   **Information**
   
   A Microsoft Visual Studio version from 2012 is recommended, due to the better-integrated XAML designer.

5.1 **Creation of a simple WPF user control with code behind function**

   The creation and incorporation of a simple user control is described in this chapter. Because only the fundamental mechanisms/process for integration into zenon is described, the functionality of the user control is limited to the addition of two values. There is intentionally no enhanced error handling or explicit completion, in order to retain the simplicity of this example.
CREATE WPF USER CONTROL

1. Create a new **Solution** and a **WPF User Control Library** in this in Visual Studio.
   
   The .NET framework version 4 was selected for this example. A different version can also be selected, which must be installed on the target system on which Runtime will subsequently be started.

   **Info:** If the corresponding project template does not appear in the list of available templates, this can be added by means of the search (field at the top right of the dialog).

In our example, the project is given the name **WPFUserControlLibrary**.
2. Create 3 text boxes and a button in the UserControl1.xaml file:

![UserControl1.xaml](image)

3. Add the following code in the click event of the button:

```csharp
private void buttonAdd_Click(object sender, RoutedEventArgs e)
{
    try
    {
        textBoxC.Text = (Convert.ToInt32(textBoxA.Text) + Convert.ToInt32(textBoxB.Text)).ToString();
    }
    catch (Exception ex)
    {
        textBoxC.Text = "Error adding values: " + ex.Message;
    }
}
```

Now you have the user control with the required functionality available. However, because zenon can only display XAML files that do not link to a code-behind file, an additional XAML file is needed that references the library (assembly) that has just been built.

**CREATION OF THE XAML FILE (WITHOUT CODE BEHIND) FOR ZENON**

Proceed as follows to create the XAML file required in zenon.

1. Create a further project, again as a WPF User Control Library
2. It was called WPFUserControlNoCodeBehind in our example.
3. Insert a reference to the project that has just been built into this new project.

![Reference Manager - WPFUserControlNoCodeBehind](reference_image)

4. The XAML files (`UserControl1.xaml`) looks as follows:

```xml
<UserControl x:Class="WPFUserControlNoCodeBehind.UserControl1"
xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
xmlns:d="http://schemas.microsoft.com/expression/blend/2008"
mc:Ignorable="d"
xmlns:local="clr-namespace:WPFUserControlNoCodeBehind"
xmlns="http://schemas.microsoft.com/winfx/2006/xaml"
mc:Ignorable="d"
>
  <Grid>
    ...
  </Grid>
</UserControl>
```

5. Because all necessary content is contained in the DLL that has been created and no code-behind file can be used, delete the following lines:

   ```xml
   x:Class="WPFUserControlNoCodeBehind.UserControl1"
   xmlns:local="clr-namespace:WPFUserControlNoCodeBehind"
   ```

6. Also delete (for the designer's size setting) the following lines:

   ```xml
   mc:Ignorable="d"
   d:DesignHeight="300" d:DesignWidth="300"
   ```

7. Delete the code-behind file (`UserControl1.xaml.cs`) in this project.

8. Drag the user control that has been created beforehand (for the project `WPFUserControlLibrary`) over the toolbox in the XAML designer.

9. Assign a name for the grid and the user control.

   **Attention:** If no name is given here, these elements do not appear in the linking dialog in the zenon Editor and thus cannot be made dynamic.
10. The XAML file should now look as follows:

```xml
<UserControl xmlns="http://schemas.microsoft.com/winfax/2006/xaml/presentation"
             xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
             xmlns:d="http://schemas.microsoft.com/expression/blend/2008"
             mc:Ignorable="d">
    <Grid Name="MainGrid">
        <UserControlLibrary:UserControl Name="AdditionControl" HorizontalAlignment="Left" VerticalAlignment="Top"/>
    </MainGrid>
</UserControl>
```

In the next step, how the DLL and XAML file are incorporated into zenon is explained.

**STEPS IN ZENON**

1. Open the zenon Editor
2. Go to File -> Graphics.
3. Select Add file... in the context menu
4. Select the XAML file at the save location (*UserControl1.xaml* from the *WPFUserControlNoCodeBehind* project) and add this:
5. Insert the DLL with the functionality for the XAML file.
   To do this:
   a) Select, in the context menu, File -> Other Add file...
b) Select the file **WPFUserControlLibrary.dll** (from the output path) of the first project (**WPFUserControlLibrary**).

6. Create a zenon screen.

7. Add a WPF element and select the previously-incorporated XAML file.

You should now see the following in the zenon Editor:

8. Start zenon Runtime in order to also test the control there.

Information

The XAML file and referenced assemblies can also be saved in compiled form as a *.cdwpf file. Only one file thus need to be imported in the Editor (under Files -> Graphics). Further information on this can be found in the CDWPF files (collective files) (on page 47) chapter.

**Hint:** When developing a WPF user control, it is usually more practical to insert the XAML file and the referenced DLL(s) separately. This makes the replacement of the DLL and debugging easier. Further information on the topic of debugging in the Debugging the WPF user control in Runtime (on page 29).
5.2 Debugging the WPF user control in Runtime

To debug the WPF user control in Runtime, proceed as follows.

In this example, the control described in the Creation of a simple WPF user controls with code behind function (on page 23) is used.

DEBUGGING BY MEANS OF ATTACH TO PROCESS

1. Ensure that zenon Runtime has been started and a screen with the WPF user control is open. Furthermore, ensure that the DLL that is currently being used corresponds to the build (Version) of the user control project (WPFUserControlLibrary).

2. Set a breakpoint in the click event of the button in the Visual Studio project

```csharp
private void buttonAdd_Click(object sender, RoutedEventArgs e)
{
    try
    {
        textBoxC.Text = (Convert.ToInt32(textBoxA.Text) + Convert.ToInt32(textBoxB.Text)).ToString();
    }
    catch (Exception ex)
    {
        textBoxC.Text = "Error adding values: " + ex.Message;
    }
}
```

3. In Visual Studio, under Debug, select the Attach to Process menu item.
4. Select the zenon Runtime process

5. Under **Attach to**, select either **Automatic** or the corresponding .NET framework version (**v4.x** in this case)

6. Click on **Attach**.
7. Now trigger the breakpoint in which you enter values into the WPF control in zenon Runtime and click on the button

![Code snippet](image)

**DEBUG USING START EXTERNAL PROGRAM**

1. Ensure that zenon Runtime has been closed.
2. Ensure that, in the zenon Editor, the project that contains the WPF user control has been set as the start project.
3. Ensure that the user control project (WPFUserControlLibrary) is set as the start project in Visual Studio.

![Visual Studio project settings](image)

4. In the project properties of the Visual Studio project, select under **Debug**, for **Start action**: **Start external program**
5. For **Start external program**, select the path of the zenon Runtime application.
6. Under **Working Directory**, select the \wpfcache folder of the Runtime files (\..\PROJECTNAME\RT\FILES\zenon\custom\wpfcache)
**Hint:** In the selected project in the zenon Editor, press the keyboard combination **CTRL+ALT+R** in order to jump directly to the root directory of the Runtime files.

7. In the project properties, enter \wpfache folder of the Runtime files as the output path under Build

8. Create the project in Visual Studio

9. Start debugging in Visual Studio with **Start**

10. zenon Runtime is now started automatically.

11. Trigger the breakpoint by entering values in the WPF control in zenon Runtime and click on the button
Information

When starting zenon Runtime, the assemblies (DLLs) referenced in the WPF user controls from the `\FILES\zenon\custom\additional` folder, and/or the assemblies from CDWPF files in the `\FILES\zenon\custom\wpfcache` folder are copied. If the file version of the DLL in the `wpfache` folder is one higher than the version of the "original file", it is not replaced!

For debugging, it is thus sufficient to only replace the file that is on the `wpfache` folder directly.

For delivery, it must be ensured that the current version of the DLL is present in the `additional` folder or the CDWPF file!

**Attention**: If only the DLL is updated in the `additional` folder or in the CDWPF, but the version number is not increased, the DLL must be deleted manually in the `wpfcache` folder, because it is not updated otherwise (due to the above-described mechanism).

Attention

Assemblies are only removed after loading when the application is ended. This means:

If a WPF file with a referenced assembly in zenon is displayed, then this assembly is loaded in the memory until zenon is ended, even if the screen is closed again. If you would like to remove an assembly from the Files/Other folder, the Editor must first be restarted, so that the assembly is removed.

5.3 Data exchange between zenon and WPF user controls

There are different possibilities for exchanging data between zenon and WPF user controls.

- Data exchange using dependency properties (on page 34)
- Data replacement via VSTA (on page 37)
5.3.1 Data exchange using dependency properties

The most elegant and secure way to exchange data between zenon and self-created WPF user controls is by using dependency properties.

The WPF user control project created in the Creating a simple WPF user controls with code behind function (on page 23) serves as a basis (WPFUserControlLibrary).

In this chapter too, the focus is purely on the core theme (dependency properties and data exchange between the user control and zenon in this case). Specific WPF features such as data connection, etc., as well as explicit error handling, are not covered.

ADDITIONS TO THE CODE

1. Create the TextChanged Event for the textBoxA element in the UserControl1.xaml file

    TextChanged="textBoxA_TextChanged"

2. Add the following lines of code in the UserControl1 class of the code behind file (UserControl1.xaml.cs)

    /// <summary>
    /// Gets or sets the ValueA.
    /// </summary>
    public double ValueA
    {
        get
        {
            return (double)GetValue(ValueADependencyProperty);
        }
        set
        {
            SetValue(ValueADependencyProperty, value);
        }
    }

    /// <summary>
    /// Dependency property for ValueA
    /// </summary>
    public static readonly DependencyProperty ValueADependencyProperty = DependencyProperty.Register("ValueA", typeof(double), typeof(UserControl1), new FrameworkPropertyMetadata(0.0, new PropertyChangedCallback(OnValueADependencyPropertyChanged)));

    void OnValueADependencyPropertyChanged(DependencyObject dependencyObject, DependencyPropertyChangedEventArgs e)
    {
        if (dependencyObject is UserControl1)
        {
            UserControl1 valueADependencyPropertyOwner = (UserControl1)dependencyObject;

            // Code to handle the change in ValueA property
        }
    }
/// <summary>
/// Called when [value a dependency property changed].
/// </summary>
/// <param name="source">The source.</param>
/// <param name="e">The <see cref="DependencyPropertyChangedEventArgs"/> instance containing the event data.</param>
private static void OnValueChanged(DependencyObject source, DependencyPropertyChangedEventArgs e)
{
    UserControl1 control = source as UserControl1;
    if (control != null)
    {
        try
        {
            control.ValueA = (double)e.NewValue;
            control.textBoxA.Text = control.ValueA.ToString();
        }
        catch (Exception)
        {
        }
    }
}

/// <summary>
/// Handles the TextChanged event of the textBoxA control.
/// </summary>
/// <param name="sender">The source of the event.</param>
/// <param name="e">The <see cref="TextChangedEventArgs"/> instance containing the event data.</param>
private void textBoxA_TextChanged(object sender, TextChangedEventArgs e)
{
    try
    {
        ValueA = Convert.ToDouble(textBoxA.Text);
    }
    catch (Exception)
    {
    }
}
Then build the solution.

**Information**

A numerical property (**double**) is used in this example. Other simple data types (such as **bool**, **string**, **int**, etc.) can also be used.

**LINKING IN ZENON**

1. Update the WPF user control (DLL) in the zenon Editor.
   
   To do this, proceed as described in the Creating a simple WPF user controls with code behind function (on page 23) and note that, under certain circumstances, the zenon Editor must be restarted if another version of the assembly (DLL) has been loaded by the Editor.

2. Create a numeric variable in zenon and link it to a dynamic text element in the screen next to the WPF element with your user control.

3. Open the screen that contains the WPF element and select, for the WPF element, under **WPF links: Configuration**

4. Expand the node in the tree at the top left and select **AdditionControl**
5. Select the line with ValueA (this is the name of the property that was created in the code beforehand) and select, for Type of link, Variable.

**Hint:** Give Properties a prefix so that this can be found more easily, for example: _ValueA

6. In the column under Linkage, print out the variable that was created in zenon beforehand.

7. Confirm the dialog with OK and build the Runtime files.

8. Start Runtime in order to test the WPF user control.

9. If the value is changed in user control, the value automatically changes in zenon and vice versa.

10. Of course you can debug the control as described in the Debugging the WPF user control in Runtime (on page 29) chapter, as well as create further dependency properties.

   **Information**

   *The UserControl_Loaded event can be used in order to (automatically) access the values of the dependency property during initialization (when calling up the user control) for example.*

5.3.2 Data replacement via VSTA

Data can also be exchanged between zenon and WPF user controls using VSTA.

The API element methods:

- `get_WPFProperty` (reading of values)
- `set_WPFProperty` (writing of values)
are used for this.

The example used here is based on the example used in the Data exchange using dependency properties (on page 34) chapter.

CREATION OF A VSTA MACRO FOR DATA EXCHANGE BETWEEN ZENON AND THE WPF USER CONTROL

1. Create the following VSTA macro in the project add-in of the zenon project

```csharp
/// <summary>
/// Sample Macro for data exchange between VSTA and a WPF User Control
/// </summary>
public void MacroWPFAccess()
{
    //Get the Screen and Element hosting the WPF User Control
    zenOn.HomeItem myWPFScreen = this.HomeItem.Item("Screen");
    zenOn.Element myWPFElement = myWPFScreen.Elements().Item("WPF Element");

    //Read the current value from the WPF Element property
    double currentValue = Convert.ToDouble((myWPFElement.get_WPFProperty("AdditionControl", "ValueA")));

    //Double the value and write it back to the WPF Element property
    myWPFElement.set_WPFProperty("AdditionControl", "ValueA", currentValue * 2);
}
```

Whereby:

- "Screen" is the name of the zenon screen in which the WPF element is located
- "WPF_Element" is the name of the WPF element that contains the WPF user control
- "AdditionControl" is the name of the WPF user controls itself (defined in the (UserControl1.xaml file)
- "ValueA" is the name of the user control property

2. Create an execute VSTA macro function and link this to a button in the screen in which the WPF element is also located

3. Start Runtime to test changes

When executing the macro, the value is read by the control, doubled and written back.

Information

The user control properties used for this method of data exchange need not necessarily be dependency properties, as outlined in this example. "Standard" properties can also be used, see in relation to this the Access via VSTA "variable link" (on page 39) chapter.
5.4 Access to the zenon (Runtime) object model from a WPF user control

There are different possibilities for access to the zenon object model from a WPF user control. This is explained in more detail in the following chapters.

5.4.1 Access via VSTA "variable link"

In order to get access to the zenon Runtime COM interface by means of "variable link", proceed as follows. The creation of a simple WPF user controls with code behind function (on page 23) serves as an initial example.

Information

The following code is intended to show an example of how the COM implements access to zenon Runtime and in doing so limits itself to the basic functionality. There is no explicit error handling, etc.

NECESSARY AMENDMENTS IN WPF USER CONTROL

The following steps are necessary in the WPF user control project (WPFUserControlLibrary).

Firstly, a reference to the zenon COM interface must be incorporated.

After this, the following code must be inserted in the UserControl1 class:
// The zenon Project
zenOn.Project zenonProject = null;

/// <summary>
/// Property for the Variable link via VSTA
/// </summary>
public object zenonVariableLink
{
    get { return null; }
    set
    {
        if (value != null && zenonProject == null)
        {
            zenOn.Variable zenonVariable;
            try
            {
                zenonVariable = (zenOn.Variable)value;
            }
            catch (Exception)
            {
                return;
            }
            if ((zenonVariable != null) && (!string.IsNullOrEmpty(zenonVariable.Name)))
            {
                zenonProject = zenonVariable.Parent.Parent;
            }
        }
    }
}

/// <summary>
/// Trigger used to notify the control from VSTA to release the COM resources
/// </summary>
public object zenonReleaseTrigger
{
    get { return null; }
    set
{  
    if ((bool)value &amp;&amp; zenonProject != null)  
    {  
        try  
        {  
            Marshal.FinalReleaseComObject(zenonProject);  
        }  
        catch (Exception)  
        {  
            return;  
        }  
        zenonProject = null;  
        GC.Collect();  
        GC.WaitForPendingFinalizers();  
        GC.Collect();  
    }  
}  

Whereby access to the properties zenonVariableLink (to initialize the COM object) and zenonReleaseTrigger (to unlock the COM object) are subsequently accessed from VSTA (write).

In order to test the COM access quickly very easily, it is possible to insert the following line of code in the existing button-click event of the user control.

```csharp
private void buttonAdd_Click(object sender, RoutedEventArgs e)  
{  
    if (zenonProject != null)  
    {  
        MessageBox.Show(zenonProject.Name);  
    }  
    return;  
...
```

Information

A zenOn.Project variable is used in this example. Of course other objects such as events, etc. of the zenon object model can also be used.
NECESSARY AMENDMENTS IN THE ZENON PROJECT/VSTA CODE

The following steps are necessary in the VSTA code:

Creation of a VSTA macro for the initialization

```csharp
/// <summary>
/// Macro for API initialization in the WPF User Control
/// </summary>
public void MacroWPFInit()
{
    zenOn.IDynPicture myWPFScreen = this.DynPictures().Item("Screen");
    zenOn.IElement myWPFElement = myWPFScreen.Elements().Item("WPF_Element");
    myWPFElement.set_WPFProperty("AdditionControl", "zenonVariableLink", this.Variables().Item(0));
}
```

Creation of a VSTA macro for approval

```csharp
/// <summary>
/// Macro for API release in the WPF User Control
/// </summary>
public void MacroWPFRelease()
{
    zenOn.IDynPicture myWPFScreen = this.DynPictures().Item("Screen");
    zenOn.IElement myWPFElement = myWPFScreen.Elements().Item("WPF_Element");
    myWPFElement.set_WPFProperty("AdditionControl", "zenonReleaseTrigger", true);
}
```

Create two execute VSTA macro functions that are linked with buttons, which are in the same screen as the WPF element.

Now start Runtime in order to test the functionality

- Execute the macro for initialization
Click on the button in the WPF user control; a message box with the project name of the project appears.

Execute the macro for release.

In order to debug the user control, it is possible to proceed as described in the Debugging the WPF user control in Runtime (on page 29).

**Hint**

The initialization and release of the COM object in this example is only carried out for simple demonstration using VSTA macro functions. Depending on the application, and/or in practice, events in VSTA are better suited to this.

For example, the code for initialization in the `_Open` event of the screen can be executed with the WPF element and the code for release in the `_Close` event.

The mechanism described here is also used in the Display of WPF elements in the zenon Web Client (on page 90) chapter.

**Attention**

If COM objects are used in WPF user controls, these must always be explicitly approved before destroying the WPF user control (before closing the screen, before closing Runtime, before reloading).

5.4.2 Access via marshaling

In order to get access to the zenon Runtime COM interface by means of marshaling, proceed as follows. The creation of a simple WPF user controls with code behind function (on page 23) serves as an initial example.
NECESSARY AMENDMENTS IN WPF USER CONTROL

The following steps are necessary in the WPF user control project (WPFUserControlLibrary).

Firstly, a reference to the zenon COM interface must be incorporated.

```
zenOn.Project zenonProject = null;
```

Furthermore, the constructor of the user controls must be supplemented with the lines below (to initialize the COM object):

```
/// <summary>
/// Constructor for UserControl1, initialize COM Object
/// </summary>

public UserControl1()
{
    InitializeComponent();

    try
    {
```

zenonProject =
}
catch (Exception)
{
}
}

The COM object must be approved in the UserControl_Unloaded event:

/// <summary>
/// Release COM Object
/// </summary>
private void UserControl_Unloaded(object sender, RoutedEventArgs e)
{
    try
    {
        if (zenonProject != null)
        {
            Marshal.FinalReleaseComObject(zenonProject);
            zenonProject = null;
        }
    }
    catch (Exception)
    {
    }
}

In order to test the COM access quickly very easily, it is possible to insert the following line of code in the existing button click event of the user control.

private void buttonAdd_Click(object sender, RoutedEventArgs e)
{
    if (zenonProject != null)
    {
        MessageBox.Show(zenonProject.Name);
    }
    return;
Now build the solution and update the WPF user control in the zenon project.  
Start Runtime to test the user control.

In order to debug the user control, it is possible to proceed as described in the Debugging the WPF user control in Runtime (on page 29).

**Information**

A `zenOn.Project` variable is used in this example. Of course other objects such as events, etc. of the zenon object model can also be used.

**Attention**

If COM objects are used in WPF user controls, these must always be explicitly approved before destroying the WPF user control (before closing the screen, before closing Runtime, before reloading).

**Information**

No access by means of marshaling is possible in the zenon web client. If access to the COM interface is required there, the method described in the Access via VSTA "variable link" (on page 39) must be used.
6. Engineering in zenon

In order to be able to use WPF user controls in zenon, version 3.5 (or higher, depending on the .NET framework version used in the user control) of the Microsoft framework must be used on both the Editor computer and the Runtime computer.

CONDITIONS FOR THE WPF DISPLAY IN ZENON

The dynamization is currently available for simple variable types (numerical data types as well as string). Arrays and structures cannot be dynamized.

Therefore the following WPF functions can be implemented in zenon:

- Element properties that correspond to simple data types, such as String, Int, Double, Bool etc.
- Element properties of the "Object" type, which can be set with simple data types
- Element events can be used with functions; the parameters of the events are not however available in and cannot be evaluated in zenon
- Element transformation, for which a RenderTransform is present for the element in the XAML file

Attention: if the content is outside of the area of the WPF element during transformation, this is not labeled

Notes on dBase: No shade can be displayed in zenon for WPF elements.

Attention: If the Runtime files were created for a project for a version before 6.50, existing WPF elements are not included into Runtime screens.

6.1 CDWPF files (collective files)

A CDWPF file (with the suffix *.cdwpf) is an renamed ZIP file that contains the following components:

- XAML file (to reference the user control assembly)
- DLL file (the actual WPF user control, optional)
- Preview graphics (for preview, optional)
Rules for the use of collective files:

- The files (XAML, DLL, preview graphics) can be in the CDWPF file directly or in a joint folder.
- The name of the collective file should correspond to the names of the XAML file.
- Only one XAML file may be contained.
- The preview graphic should be small and no more than 64 pixels high.
  Name of the preview file: `preview.png` or the name of the XAML file with the suffix `.png`.
- Any number of assemblies can be used. The distinction is made on the basis of the file version.
- Collective files do not need to contain an assembly.
- All subfolders are examined and only taken into account with `.dll`, `.xaml` or `.png` files.
- If a collective file (`*.cdwpf`) is replaced by a file with a different version, all corresponding CDWPF files in all symbols and images in all projects must be adapted.

6.2 create WPF element

To create a WPF element

1. In the elements toolbar, select the symbol for WPF element or the Elements entry in the menu
2. Select the start point in the main window.
3. Pull open the element with the mouse.
4. In properties, select Representation the property XAML file in the group.
5. The file selection dialog opens.
6. Select the desired file
   Files of the following formats are valid:
   - `*.xaml`: Extensible Application Markup Language
   - `*.cdwpf`: WPF collective file, also shows preview image
   (The file must already be present in the Project Manager under Files/graphics or created in the dialog.)
7. Configure the links (on page 49).

Information

If referenced assemblies are used, note the instructions in the Referenced assemblies (on page 8) chapter.
6.3 Configuration of the linking

To configure a WPF element

1. In properties, select **WPF links** the property **Configuration** in the group.
2. The dialog with three tabs opens with a preview of the XAML file and the elements present in the file

**DIALOG CONFIGURATION**
### Parameters

<table>
<thead>
<tr>
<th>Available elements</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows the named file elements in a tree structure. The selected element can be linked with process data.</td>
<td><strong>WPF</strong> is assigned to process data based on the element name. Therefore elements are only shown if they and the attendant elements have a name. Allocations are configured and shown in the <strong>Properties</strong>, <strong>Events</strong>, <strong>Transformations</strong> tabs. <strong>Hint</strong>: If the corresponding elements are not displayed, check in the XAML file to see if this has a name (for example: <code>&lt;Grid Name=&quot;GridName&quot;&gt;</code>).</td>
</tr>
<tr>
<td>Preview</td>
<td>The selected element is shown flashing in the preview.</td>
</tr>
<tr>
<td><strong>Properties</strong> (on page 51)</td>
<td>Configuration and display of properties (variables, authorizations, interlockings, linked values).</td>
</tr>
<tr>
<td><strong>Events</strong> (on page 57)</td>
<td>Configuration and display of events (functions).</td>
</tr>
<tr>
<td><strong>Transformations</strong> (on page 58)</td>
<td>Configuration and display of transformations.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Name of the property.</td>
</tr>
<tr>
<td><strong>Connection</strong></td>
<td>Selection of link.</td>
</tr>
<tr>
<td><strong>Link type</strong></td>
<td>Type of link (variable, authorization, function)</td>
</tr>
<tr>
<td><strong>WPF info</strong></td>
<td>Shows the current value for properties in WPF content. For the user, it is directly visible what type of property it is (Boolean, string, etc.).</td>
</tr>
<tr>
<td><strong>Linked</strong></td>
<td>Shows if a property is currently being used.</td>
</tr>
</tbody>
</table>

**Information**

_Only logical objects can be displayed in the configuration dialog. Visual objects are not displayed. You can read about backgrounds and how visual objects can be animated in the Allocation of zenon object to WPF content._

### EDIT HYPERLINKS

All configured hyperlinks can be edited from the properties of the element. Click on the element and open the property group **WPF links**. Hyperlinks can be further configured here, without having to open the dialog.

**Limitations:**

- The linking type cannot be changed here.
- New linkings can only be created via the configuration dialog.
• Insertion of a WPF elements into a symbol: WPF linkings cannot be exported.

6.3.1 Properties

The properties enable the linking of:
• Variables (on page 53)
• Values (on page 54)
• Authorizations and interlockings (on page 55)
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name of the property.</td>
</tr>
<tr>
<td><strong>Connection</strong></td>
<td>Linked variable, authorization or linked value. Clicking in the column opens</td>
</tr>
<tr>
<td></td>
<td>the respective selection dialog, depending on the entry in the <strong>Link type</strong></td>
</tr>
<tr>
<td><strong>Link type</strong></td>
<td>Selection of linking.</td>
</tr>
<tr>
<td><strong>WPF info</strong></td>
<td>Shows the current value for properties in WPF content. For the user, it is</td>
</tr>
<tr>
<td></td>
<td>directly visible what type of property it is (Boolean, string, etc.).</td>
</tr>
<tr>
<td><strong>Linked</strong></td>
<td>Shows if a property is currently being used. Not contained by default in the</td>
</tr>
<tr>
<td></td>
<td>view, but can be selected using Context menu-&gt;Column selection.</td>
</tr>
</tbody>
</table>

**CREATE LINK**

To create a link:

1. Highlight the line with the property that is to be linked
2. Click in the **Link type cell**
3. Select the desired link from the drop-down list.
   - <not linked> (deletes an existing link)
   - Authorization/Interlocking
   - Constant value
   - Variable
4. Click in the **Link cell**
5. The dialog for configuring the desired link opens

---

**Information**

Properties of WPF and zenon can be different. If, for example the visibility property is linked, there are three values available in .NET:

- 0 - visible
- 1 - invisible
- 2 - collapsed

These values must be displayed via the linked zenon variable.
Link variable

To link a variable with a WPF property:

1. Highlight the line with the property that is to be linked
2. Click in the Link type cell
3. Select from the variable drop down list
4. Click in the Link cell
5. The dialog for configuring the variables opens

This dialog also applies for the selection of variables with transformations (on page 58). The configuration also makes it possible to convert from zenon into WPF units.
### Parameters | Description
--- | ---
Linked variables | Selection of the variable to be linked. A click on the ... button opens the selection dialog.
Value range of WPF element | Data to convert variable values into WPF values.
Convert value range | **Active:** WPF unit conversion is switched on.

**Effect on Runtime:** The current zenon value (incl. zenon unit) is converted to the WPF range using standardized minimum and maximum values.

**For example:** The value of a variable varies from 100 to 200. With the variables, the standardized range is set to 100 - 200. The aim is to display this change in value using a WPF rotary knob. For this:

- for **Transformations**, the RotateTransform.Angle property is linked to the variables
- **Adjust value** activated
- a WPF value range of 0 to 360 is configured

Now the rotary knob can be turned at a value of 150, for example, by 180 degrees.

Minimum | Defines the lowest WPF value.
Maximum | Defines the highest WPF value.
OK | Accepts settings and ends the dialog.
Cancel | Discards settings and ends the dialog.
Help | Opens online help.

### Link values

Linked values can either be a **String** or a numerical value of the type **Double**. When selecting the screen, the selected value is sent in WPF content after loading the WPF content.

To link a value with a WPF property:

1. Highlight the line with the property that is to be linked
2. Click in the **Link type cell**
3. Select **Value linkings** from the drop-down list
4. Click in the **Link cell**
5. The dialog for configuration of value linking opens

![Configuration dialog](image)

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linked value:</td>
<td>Entry of a numerical value or string value.</td>
</tr>
<tr>
<td>Use string</td>
<td><strong>Active</strong>: A string value is used instead of a numerical value.</td>
</tr>
<tr>
<td></td>
<td>The language of string values can be switched. The text is translated in</td>
</tr>
<tr>
<td></td>
<td>Runtime when the screen is called up and sent in WPF content. If the</td>
</tr>
<tr>
<td></td>
<td>language is switched whilst the screen is opened, the string value is</td>
</tr>
<tr>
<td></td>
<td>retranslated and sent.</td>
</tr>
<tr>
<td>String value/numerical value</td>
<td>Depending on what is selected for the <strong>Use string</strong> property, a numerical</td>
</tr>
<tr>
<td></td>
<td>value or a string value is entered into this field. For numerical values,</td>
</tr>
<tr>
<td></td>
<td>a unit of measurement can also be selected.</td>
</tr>
<tr>
<td>Unit:</td>
<td>Selection of a unit of measurement from the drop down list. You must</td>
</tr>
<tr>
<td></td>
<td>have configured this in unit switching beforehand.</td>
</tr>
<tr>
<td></td>
<td>The unit of measurement is allocated with the numerical value. If the</td>
</tr>
<tr>
<td></td>
<td>units are switched in Runtime, the value is converted to the new unit of</td>
</tr>
<tr>
<td></td>
<td>measurement and sent to WPF content.</td>
</tr>
<tr>
<td>OK</td>
<td>Accepts settings and ends the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Discards settings and ends the dialog.</td>
</tr>
<tr>
<td>Help</td>
<td>Opens online help.</td>
</tr>
</tbody>
</table>

**Link authorization or interlocking**

Authorizations cannot be granted for the whole WPF element. The element is allocated a user level. Authorizations are granted within the user level for individual controls. If an authorization is active, the value 1 is written to the element.

To link an authorization or interlocking with a WPF property:

1. Highlight the line with the property that is to be linked
2. Click in the **Link type cell**
3. Select **Authorization/interlocking** from the drop down menu
4. Click in the **Link** cell
5. The dialog for configuring the authorizations opens

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Link authorization/interlocking</strong></td>
<td>Setting the authorizations.</td>
</tr>
<tr>
<td><strong>Linked status</strong></td>
<td>Selection of an authorization that is linked to a WPF control from the drop down list. For example, visibility and operability of a WPF button can depend on a user’s status.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Authorization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorization available</td>
<td>If the user has sufficient rights to operate the <strong>WPF element</strong>, a value of 1 is written to the property.</td>
</tr>
<tr>
<td>Authorization does not exist</td>
<td>If the user does not have sufficient rights to operate the <strong>WPF element</strong>, a value of 1 is written to the property.</td>
</tr>
<tr>
<td>Not interlocked</td>
<td>If the element is not locked, the value 1 is written to the property.</td>
</tr>
<tr>
<td>Interlocked</td>
<td>If the element is locked, the value 1 is written to the property.</td>
</tr>
<tr>
<td>Can be operated</td>
<td>If authorization is present and the element is not locked, then a value of 1 is written to the property.</td>
</tr>
<tr>
<td>Cannot be operated</td>
<td>If authorization is not present or the element is not locked, then a value of 1 is written to the property.</td>
</tr>
</tbody>
</table>
6.3.2 Events

Events make it possible to link zenon functions to a WPF element.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the property.</td>
</tr>
<tr>
<td>Connection</td>
<td>Linked function. Clicking in the cell opens the configuration dialog.</td>
</tr>
<tr>
<td>Link type</td>
<td>Selection of linking. Clicking in the cell opens the selection dialog.</td>
</tr>
<tr>
<td>WPF info</td>
<td>Shows the current value for properties in WPF content. For the user, it is</td>
</tr>
<tr>
<td></td>
<td>directly visible what type of property it is (Boolean, string, etc.).</td>
</tr>
<tr>
<td>Linked</td>
<td>Shows if a property is currently being used.</td>
</tr>
<tr>
<td></td>
<td>Not contained by default in the view, but can be selected using Context</td>
</tr>
<tr>
<td></td>
<td>menu-&gt;Column selection.</td>
</tr>
</tbody>
</table>

**LINK FUNCTIONS**

To create a link:

1. Highlight the line with the property that is to be linked
2. Click in the Link type cell
3. Select from the drop down list function
4. Click in the Link cell
5. The dialog for configuring the function opens

![Configuration dialog](image)

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linked function</td>
<td>Selection of the function to be linked. Clicking on the … button opens the dialog for Function selection.</td>
</tr>
<tr>
<td>OK</td>
<td>Accepts selection and closes dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Discards changes and closes dialog.</td>
</tr>
<tr>
<td>Help</td>
<td>Opens online help.</td>
</tr>
</tbody>
</table>

### 6.3.3 Transformation

The WPF element does not support rotation. If, for example, the WPF element is in a symbol and the symbol is rotated, the WPF element does not rotate with it. Therefore there is a different mechanism for Transformation with WPF to turn elements or to otherwise transform them. These transformations are configured in the Transformation tab.
Attention: If the content is outside of the WPF element area, this part of the contents is lost or it is not shown.
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name of the property.</td>
</tr>
<tr>
<td><strong>Connection</strong></td>
<td>Selection of the linked variables. Transforms are displayed in XAML as transformation objects with their own properties. If an element supports a transformation, then the possible properties of the transformation object are displayed in list view. (more on this in: Integrate button as WPF XAML in zenon on page 100) For example, if the linked variable is set at the value of 10, then this value is written as a WPF target and the WPF element is rotated by 10°.</td>
</tr>
<tr>
<td><strong>Link type</strong></td>
<td>Selection of transformation link type.</td>
</tr>
<tr>
<td><strong>WPF info</strong></td>
<td>Shows the current value for properties in WPF content. For the user, it is directly visible what type of property it is (Boolean, string, etc.).</td>
</tr>
<tr>
<td><strong>Linked</strong></td>
<td>Shows if a property is currently being used. Not contained by default in the view, but can be selected using Context menu-&gt;Column selection.</td>
</tr>
</tbody>
</table>

**LINK TRANSFORMATIONS**

To link a transformation with a WPF property:

1. Highlight the line with the property that is to be linked
2. Click in the **Link type cell**
3. Select from the **Transformation** drop down list
4. Click in the **Link cell**
5. The dialog for configuring the variables opens

The configuration also makes it possible to convert from zenon into WPF units.
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Linked variables</strong></td>
<td>Selection of the variable to be linked. A click on the ... button opens the selection dialog.</td>
</tr>
<tr>
<td><strong>Value range of WPF element</strong></td>
<td>Data to convert variable values into WPF values.</td>
</tr>
<tr>
<td><strong>Convert value range</strong></td>
<td>Active: WPF unit conversion is switched on.</td>
</tr>
</tbody>
</table>

**Effect on Runtime**: The current zenon value (incl. zenon unit) is converted to the WPF range using standardized minimum and maximum values.

**For example**: The value of a variable varies from 100 to 200. With the variables, the standardized range is set to 100 - 200. The aim is to display this change in value using a WPF rotary knob. For this:

- for **Transformations**, the **RotateTransform.Angle** property is linked to the variables
- **Adjust value** activated
- a WPF value range of 0 to 360 is configured

Now the rotary knob can be turned at a value of 150, for example, by 180 degrees.

<table>
<thead>
<tr>
<th>Minimum</th>
<th>Defines the lowest WPF value.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum</td>
<td>Defines the highest WPF value.</td>
</tr>
<tr>
<td><strong>OK</strong></td>
<td>Accepts settings and ends the dialog.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Discards settings and ends the dialog.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Opens online help.</td>
</tr>
</tbody>
</table>

### 6.4 Validity of XAML Files

XAML files are valid subject to certain requirements:

- Correct name spaces
- No class references
- Scalability

**CORRECT NAME SPACE**

The **WPF element** can only display WPF content, i.e.: 
Only XAML files with the correct WPF namespace can be displayed by the WPF element. Files that use a Silverlight namespace cannot be loaded or displayed. However, in most cases it is suffice to change the Silverlight namespace to the WPF namespace.

WPF-Namespace:

xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"

NO USE OF CLASS REFERENCES

Because the XAML files can be loaded dynamically, it is not possible to use XAML files that contain references to classes ("class" key in header). Functions that have been programmed in independently-created C#-files cannot be used.

In order to use WPF user controls with code behind, the process as described in the Creating a simple WPF user control with code behind function (on page 23) must be carried out.

SCALABILITY

If the content of a WPF element is adjusted to the size of the WPF element, then the controls of the WPF element are interlaced in a control that offers this functionality, such as a view box for example. In addition, it must be ensured that the height and width for this elements are configured as automatic.

CHECKING AN XAML FILE TO SEE IF IT IS CORRECT

To check if an XAML file has the correct format:

- Open XAML file in Internet Explorer
  - If it can be opened without additional plug-ins (Java or similar), then it can be assumed with a high degree of certainty that this file can be loaded or displayed by zenon
  - If problems occur during loading, these are then shown in Internet Explorer and the lines in which problems arise can be clearly seen

The scaling can also be tested in this manner: If the file has been created correctly, the content will adjust to the size of the Internet Explorer window.

ERROR MESSAGE

If an invalid file is used in zenon, then an error message is displayed in the output window when loading the file in the WPF element.

For example:
"error when loading
xaml-Datei:C:\ProgramData\COPA-DATA\SQL\781b1352-59d0-437e-a173-08563c3142e9\FILES\zenon\custom\media\UserControl1.xaml

The attribute "Class" cannot be found in XML namespace "http://schemas.microsoft.com/winfx/2006/xaml". Line 7 Position 2."

6.5 Pre-built elements

zenon is already shipped with several WPF elements. More are available for download in the web shop.

All WPF elements have properties which determine the graphical design of the respective element (Dependency Properties). Setting the values via an XAML file or linking the property via zenon can directly change the look in the Runtime. The tables in the description of the individual elements contain the respective Dependency Properties, depending on the control.

Available elements:

- Analog clock (on page 64)
- Vertical bar graph (on page 65)
- Comtrade Viewer (on page 66)
- Energy class diagram (on page 77)
- Progress bar (on page 66)
- Pareto diagram (on page 78)
- Sankey diagram (on page 85)
- Round display (on page 82)
- Temperature control (on page 87)
- Universal slider (on page 88)
- Waterfall diagram (on page 89)

**REPLACING ASSEMBLY WITH A NEWER VERSION**

Per project only one assembly for a WPF element can be used in the zenon Editor as well as in the Runtime. If two versions of an assembly are available in a project, then the first loaded file is used. A user enquiry is made as to which version should be used. No further actions are needed for the maintenance of the versions used up until now. If a newer version is chosen, all corresponding CDWPF files in all symbols and images in all projects must be adapted.

**Note for Multi-Project Administration:** If an assembly in a project is replaced by a new version, it must also be replaced in all other projects that are loaded in the Editor or in Runtime.
### 6.5.1 Analog clock - AnalogClockControl

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ElementStyle</td>
<td>Shape/type of element.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ SmallNumbers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ BigNumbers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ No</td>
</tr>
<tr>
<td>ElementBackgroundBrush</td>
<td>Color of element background.</td>
<td>Brush</td>
</tr>
<tr>
<td>ElementGlasReflection</td>
<td>Activate the glass effect on the element.</td>
<td>Visibility</td>
</tr>
<tr>
<td>Offset</td>
<td>Value in hours (h) which displays the time lag to the system clock.</td>
<td>Int16</td>
</tr>
<tr>
<td>OriginText</td>
<td>Text which is displayed in the clock (e.g. location).</td>
<td>String</td>
</tr>
</tbody>
</table>
6.5.2 Bar graph vertical - VerticalBargraphControl

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CurrentValue</td>
<td>Current value which should be displayed.</td>
<td>Double</td>
</tr>
<tr>
<td>MinValue</td>
<td>Minimum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>MaxValue</td>
<td>Maximum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>MajorTicksCount</td>
<td>Number of main ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td>MinorTicksCount</td>
<td>Number of sub ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td>MajorTickColor</td>
<td>Color of main ticks on the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>MinorTickColor</td>
<td>Color of sub ticks on the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>ElementBorderBrush</td>
<td>Color of the element border.</td>
<td>Brush</td>
</tr>
<tr>
<td>ElementBackgroundBrush</td>
<td>Color of element background.</td>
<td>Brush</td>
</tr>
<tr>
<td>ElementGlasReflection</td>
<td>Activate the glass effect on the element.</td>
<td>Visibility</td>
</tr>
<tr>
<td>ElementFontFamily</td>
<td>Element font.</td>
<td>Font</td>
</tr>
<tr>
<td>ScaleFontSize</td>
<td>Font size of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleFontColor</td>
<td>Font color of the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>IndicatorBrush</td>
<td>Bar graph fill color.</td>
<td>Brush</td>
</tr>
<tr>
<td>BargraphSeparation</td>
<td>Number of bar graph division.</td>
<td>Integer</td>
</tr>
<tr>
<td>BargraphSeparationColor</td>
<td>Color of the scale division.</td>
<td>Color</td>
</tr>
</tbody>
</table>
6.5.3 Progress bar - ProgressBarControl

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CurrentValue</td>
<td>Current value which should be displayed.</td>
<td>Double</td>
</tr>
<tr>
<td>MinValue</td>
<td>Minimum value of the value area.</td>
<td>Double</td>
</tr>
<tr>
<td>MaxValue</td>
<td>Maximum value of the value area.</td>
<td>Double</td>
</tr>
<tr>
<td>ProgressbarDivisionCount</td>
<td>Number of divisions of the progress bar.</td>
<td>Integer</td>
</tr>
<tr>
<td>VisibilityText</td>
<td>Visibility of the value display.</td>
<td>Boolean</td>
</tr>
<tr>
<td>TextSize</td>
<td>Font size of the value display.</td>
<td>Double</td>
</tr>
<tr>
<td>TextColor</td>
<td>Color of the value display.</td>
<td>Color</td>
</tr>
<tr>
<td>ProgressBarBoxedColor</td>
<td>Color of the border of the progress bar.</td>
<td>Color</td>
</tr>
<tr>
<td>ProgressBarMarginDistance</td>
<td>Distance of the progress bar box from the element edge (left, top, right, down).</td>
<td>Double</td>
</tr>
<tr>
<td>ProgressBarInactiveBrush</td>
<td>Indicator color not active.</td>
<td>Brush</td>
</tr>
<tr>
<td>ProgressBarActiveBrush</td>
<td>Indicator color active.</td>
<td>Brush</td>
</tr>
<tr>
<td>ProgressBarPadding</td>
<td>Distance of the progress bar from the progress bar box (left, top, right, down).</td>
<td>Double</td>
</tr>
<tr>
<td>ElementBorderBrush</td>
<td>Color of the element border.</td>
<td>Brush</td>
</tr>
<tr>
<td>ElementBackgroundBrush</td>
<td>Color of element background.</td>
<td>Brush</td>
</tr>
</tbody>
</table>

6.5.4 COMTRADE-Viewer

The **COMTRADE-Viewer** WPF element is available to partners of COPA-DATA and is available to these via the Partner Portal.

It is for the graphical analysis of digital error and result logging of a COMTRADE file.

**Information**

The control supports IEEE C37.111 (IEEE Standard Common Format for Transient Data Exchange (COMTRADE) for Power Systems) standards-compliant files. ASCII or binary files in accordance with the 1999 or 2013 edition can be visualized.

Older files or files without a year identification are not supported. This is displayed with a warning dialog in Runtime.
Possibilities of the COMTRADE-Viewer WPF control in zenon Runtime:

- Selection of a file in the COMTRADE file format
- Exports selected objects as a CSV file.
- Visualization of the selected COMTRADE file: 
  
  - Current (sinus wave display)
  - Voltage (sinus wave display)
  - Digital signals (binary bar chart display)
  - Display of values at a selected cursor position.
  - If an element that represents neither current or voltage is selected, (such as frequency), this is visualized in both analog areas again (current and voltage).

- Navigation:
  - Zoom in and zoom out using the mouse wheel, scroll bar and Multi-Touch gestures
  - Enlargement of the area
    - Selection of the area by clicking the mouse
  - Move the display area using the right mouse button, scroll bar or Multi-Touch gestures.
Hint

To be able to transport COMTRADE files to the zenon Runtime computer, you can also use the file transfer of the IEC 61850 driver or the FTP function block of zenon Logic.

You can find further information about this in the driver documentation of the IEC 61850 driver or in the zenon Logic documentation.

LICENSING

The COMTRADE-Viewer can only be configured in the zenon Editor with a valid Energy Edition license. If there is no valid license, the WPF is displayed as grayed out in the Editor. A valid Energy Edition license is also required for display in Runtime.

Display during Runtime

The COMTRADE WPF element offers two views in Runtime:

- **Configuration view**
  - Selection of a COMTRADE configuration file
  - Selection of the elements to be displayed
- **Graph view**
  - Zoom in and zoom out
  - Display of values at a selected cursor position.
  - Export of the selected elements as an CSV file

Information

The switch between the views is integrated in the WPF element. Additional project configuration of a screen switching function is not necessary.
Runtime view - configuration page

If a screen with a configured **COMTRADE-Viewer** WPF element is called up, the display of the respective configuration page is empty.

**Note:** This also applies if, in zenon Runtime, there is a switch from one screen to another screen with the screen switching function.

![COMTRADE Viewer Configuration](image)

**COMTRADE VIEWER CONFIGURATION**

The **COMTRADE Viewer Configuration** switching, arranged vertically on the side, switches the display of the configuration to graphic view and vice versa.

**SELECT FILE**

The **Open...** button opens the file selection dialog to select a file.

There is a pre-selection for display in the file selection:

- In doing so, file pairs of *.cfg* and *.dat* files are detected. **Note:** Optional *.hdr* or *.inf* files are not taken into account.
- Only the corresponding *.dat* files are displayed.
- All attendant files (*.dat, *.cfg) are loaded by clicking on the desired file and the **OK** button.
- One file can be loaded.
After loading the file, the content of the file is shown in the Analog Channels and Digital Channels columns. The labels and units of the elements originate from the COMTRADE configuration and cannot be changed.

### ANALOG CHANNELS

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Liste der verfügbaren Kanäle]</td>
<td>Selection of the elements to be visualized. Multiple selection by clicking on the desired entry in the list. Selected elements are shown with a colored background. Another mouse click undoes the selection of the entry.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all elements from the list.</td>
</tr>
<tr>
<td>Deselect All</td>
<td>Deactivates the existing selection of elements.</td>
</tr>
</tbody>
</table>

### DIGITAL CHANNELS

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Liste der verfügbaren Kanäle]</td>
<td>Selection of the elements to be visualized Multiple selection by clicking on the desired entry in the list. Selected elements are shown with a colored background. Another mouse click undoes the selection of the entry.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all elements from the list.</td>
</tr>
<tr>
<td>Deselect All</td>
<td>Deactivates the existing selection of elements.</td>
</tr>
</tbody>
</table>

**SHOW SELECTION**

To show your selection in the graphic view, click on the **Apply** button.

**Note:** Clicking on the vertically-arranged **COMTRADE Viewer Configuration** switching only changes the view. An amended selection of the channels is not taken into account in the process.

**Runtime view - visualization of COMTRADE data**

The selected channels are visualized in the graph view of the **COMTRADE-Viewer** WPF element. The coloring can be configured in the zenon Editor.
EXPORT OF THE SELECTED DATA

The selected analog and digital channels can be exported to a CSV file with the CSV-Export button.

GRAPH VIEW

The graph view of the COMTRADE-Viewers is divided into three sections:

- Current amperage
  Upper area
- Voltage
  Mid area
- Digital channels
  Lower area

AXIS LABELING

- Horizontal axis
  The horizontal axis represents the complete time period as illustrated in the COMTRADE file (*.dat).
  The scaling of this time axis depends on the enlargement level. The higher the enlargement selected, the more detailed the time display.

- Vertical axis
  The vertical axis represents the values.
The scaling of the value axis depends on the enlargement level. The greater the enlargement selected, the more detailed the display of values.

The labeling of the analog channels is shown vertically next to the values and corresponds to the measuring unit as defined in the COMTRADE file (*.cfg).

The digital channels are displayed in the sequence as defined in the COMTRADE file (*.cfg). The channel identifier of the COMTRADE file serves as an identifier.

The color key of the graphs is shown at the head of the graph.
- The labeling of the digital channels corresponds to the channel description as defined in the COMTRADE file (*.cfg).
- The colors for each channel are assigned automatically with the configured color palette.
- The time is displayed in a footer under the graph. The start time is displayed as a text.

NAVIGATION AND ZOOM

Navigation (scroll and zoom) is always applied to all three areas of the graphic display.
- You can move the display within the horizontal time line with the scroll bar.
- Zoom in and zoom out
  - You can zoom at the current position of the mouse pointer in the graphics view or reduce the enlargement.
  - The selected area is displayed by selecting a display area with the mouse button held down.
    **Note:** The display of the values is always amended to the selected area. As a result, this can lead to a flattening of the curve in the enlarged graphic view.
  - Double clicking on the scroll bar resets the enlargement.
The precise values at the position of the mouse pointer are visualized with a display in value blocks. A crosshair offers additional visual support with the exact determination of the reading position.

Configurable control properties - color display

ENGINEERING IN THE EDITOR

The element with the name COMTRADE.CDWPF can be configured and placed in each zenon screen type.
The project configuration of Width [pixels] and Height [pixels] of the element depend on the proportions.
This prevents the COMTRADE-Viewer being displayed as distorted in Runtime.

Note: When configuring the project, ensure that there is sufficient size to guarantee a clear overview.

GRAPHICAL AMENDMENTS

You configure the graphic design in the properties of the WPF element.
You can find further information in the configuration of the linking (on page 49) chapter in this manual.

Possible color values:

- Hexadecimal color values
  
  #RRGGBB

  **Example color values:** #000000 = black, #FFFFFF = white, #FF0000 = red

- Color values by name
  
Hint

The properties for the COMTRADE-Viewer WPF element have a "z" as a starting color. Use name filtering for a clear display when configuring the linking.

CONFIGURATION PAGE

Text and background color of the configuration page.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>zConfiguratinPageTextColor</td>
<td>Text color of the configuration page</td>
<td>String</td>
</tr>
<tr>
<td>zConfigurationPageBackgroundColor</td>
<td>Background color of the configuration page</td>
<td>String</td>
</tr>
</tbody>
</table>

BUTTONS

Text and background color of the button.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>zButtonTextColor</td>
<td>Text color of the button</td>
<td>String</td>
</tr>
<tr>
<td>zButtonBackgroundColor</td>
<td>Background color of the button</td>
<td>String</td>
</tr>
</tbody>
</table>

CHART

Text color of the axis labeling or key and background color.

```
50000  60000  70000
```
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>zChartTextColor</td>
<td>Text color of the axis labeling.</td>
<td>String</td>
</tr>
<tr>
<td>zChartBackgroundColor</td>
<td>Background color of the axis labeling</td>
<td>String</td>
</tr>
</tbody>
</table>

**LABEL**

Text and background color of the display of a selected cursor position.
### Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>zChartLabelTextColor</code></td>
<td>Text color of the value display</td>
<td>String</td>
</tr>
<tr>
<td><code>zChartLabelBackgroundColor</code></td>
<td>Background color of the value display</td>
<td>String</td>
</tr>
</tbody>
</table>

### CHART

Color palette of the graph view and the attendant keys.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>zChartPalette</code></td>
<td>Color palette of the colors for graphs and keys. Referencing with color palette name (see overview). Default: if no color palette is configured, the color palette of the computer’s operating system is used.</td>
<td>String</td>
</tr>
</tbody>
</table>
6.5.5 Energy class diagram

The energy class diagram, WPF element is available to partners of COPA-DATA and is available to these via the Partner Portal.

A reaction matrix must be used to model an energy class diagram. This reaction matrix must be linked to the variable whose value is envisaged for display and distribution in energy classes. The name of the variable must be transferred to the "\textit{zVariableName}" property.

\textbf{REACTION MATRIX FOR ENERGY CLASS DIAGRAM}

The linked reaction matrix must correspond to the following schematic:

- The first status must be an area, or a "less than" definition
As many different areas as desired can then be defined.

The last status must be an area or a "greater than" definition.

The following is applicable for project configuration:

1. If the first status is an area and the value of the variable comes under this area, the first status in the diagram is shown nevertheless. The same is applicable for the last status the other way round.

2. The colors that the WPF diagram uses for the classes are the limit value colors that were defined in the reaction matrix.

3. The letters for the classes are set in alphabetical order starting with "A".

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>zenonFontID</td>
<td>ID for a font from the first font list (font size is not taken into account)</td>
<td>Integer</td>
</tr>
<tr>
<td>zenonNumberOfDecimalPlaces</td>
<td>Number of displayed decimal points</td>
<td>Integer</td>
</tr>
<tr>
<td>zenonVariableName</td>
<td>Name of the variable to be displayed.</td>
<td>String</td>
</tr>
</tbody>
</table>

Note: Additional VSTA programming is necessary for the display of the energy class diagram in the zenon web client. You can find details on this in the display of WPF elements in the zenon web client (on page 90).

6.5.6 Pareto diagram

The Pareto diagram, WPF element is available to partners of COPA-DATA and is available to these via the Partner Portal.

An example of a Pareto diagram in Runtime is shown below:
The following settings can be made in the WPF configuration window under **COPADATA-ELEMENT**:  

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>zenonBarColor1</th>
<th>Color of the first Bar</th>
<th>Color (String)</th>
</tr>
</thead>
<tbody>
<tr>
<td>zenonBarColor2</td>
<td>Color of the second Bar</td>
<td>Color (String)</td>
</tr>
<tr>
<td>zenonBarColor3</td>
<td>Color of the third Bar</td>
<td>Color (String)</td>
</tr>
<tr>
<td>zenonBarColor4</td>
<td>Color of the fourth Bar</td>
<td>Color (String)</td>
</tr>
<tr>
<td>zenonBarColor5</td>
<td>Color of element fifth Bar</td>
<td>Color (String)</td>
</tr>
<tr>
<td>zenonBarColor6</td>
<td>Color of element sixth Bar</td>
<td>Color (String)</td>
</tr>
<tr>
<td>zenonBarColor7</td>
<td>Color of element seventh Bar</td>
<td>Color (String)</td>
</tr>
<tr>
<td>zenonBarColor8</td>
<td>Color of element eighth Bar</td>
<td>Color (String)</td>
</tr>
<tr>
<td>zenonBarColor9</td>
<td>Color of element ninth Bar</td>
<td>Color (String)</td>
</tr>
<tr>
<td>zenonBarColor10</td>
<td>Color of element tenth Bar</td>
<td>Color (String)</td>
</tr>
<tr>
<td>zenonColorPercentageLine</td>
<td>Color of the percentage line (relative sum frequency).</td>
<td>Color (String)</td>
</tr>
<tr>
<td>zenonLineVisibility</td>
<td>Visibility of the percentage line (relative sum frequency).</td>
<td>Boolean</td>
</tr>
<tr>
<td>zenonVariable1_Label</td>
<td>Labeling for the 1st Bar</td>
<td>String</td>
</tr>
<tr>
<td>zenonVariable1_Value</td>
<td>Value of the 1st Bar</td>
<td>Double</td>
</tr>
<tr>
<td>zenonVariable2_Label</td>
<td>Labeling for the 2nd Bar</td>
<td>String</td>
</tr>
<tr>
<td>zenonVariable2_Value</td>
<td>Value of the 2nd Bar</td>
<td>Double</td>
</tr>
<tr>
<td>zenonVariable3_Label</td>
<td>Labeling for the 3rd Bar</td>
<td>String</td>
</tr>
<tr>
<td>zenonVariable3_Value</td>
<td>Value of the 3rd Bar</td>
<td>Double</td>
</tr>
<tr>
<td>zenonVariable4_Label</td>
<td>Labeling for the 4th Bar</td>
<td>String</td>
</tr>
<tr>
<td>zenonVariable4_Value</td>
<td>Value of the 4th Bar</td>
<td>Double</td>
</tr>
<tr>
<td>zenonVariable5_Label</td>
<td>Labeling for the 5th Bar</td>
<td>String</td>
</tr>
<tr>
<td>zenonVariable5_Value</td>
<td>Value of the 5th Bar</td>
<td>Double</td>
</tr>
<tr>
<td>zenonVariable6_Label</td>
<td>Labeling for the 6th Bar</td>
<td>String</td>
</tr>
<tr>
<td>zenonVariable6_Value</td>
<td>Value of the 6th Bar</td>
<td>Double</td>
</tr>
<tr>
<td>zenonVariable7_Label</td>
<td>Labeling for the 7th Bar</td>
<td>String</td>
</tr>
<tr>
<td>zenonVariable7_Value</td>
<td>Value of the 7th Bar</td>
<td>Double</td>
</tr>
<tr>
<td>zenonVariable8_Label</td>
<td>Labeling for the 8th Bar</td>
<td>String</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>zenonVariable8_Value</td>
<td>Value of the 8th Bar</td>
<td>Double</td>
</tr>
<tr>
<td>zenonVariable9_Label</td>
<td>Labeling for the 9th Bar</td>
<td>String</td>
</tr>
<tr>
<td>zenonVariable9_Value</td>
<td>Value of the 9th Bar</td>
<td>Double</td>
</tr>
<tr>
<td>zenonVariable10_Label</td>
<td>Labeling for the 10th Bar</td>
<td>String</td>
</tr>
<tr>
<td>zenonVariable10_Value</td>
<td>Value of the 10th Bar</td>
<td>Double</td>
</tr>
</tbody>
</table>

The following events can be used and linked to zenon functions:

<table>
<thead>
<tr>
<th>Event</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>zenonBar1Click</td>
<td>Function that is executed when the 1st bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar2Click</td>
<td>Function that is executed when the 2nd bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar3Click</td>
<td>Function that is executed when the 3rd bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar4Click</td>
<td>Function that is executed when the 4th bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar5Click</td>
<td>Function that is executed when the 5th bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar6Click</td>
<td>Function that is executed when the 6th bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar7Click</td>
<td>Function that is executed when the 7th bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar8Click</td>
<td>Function that is executed when the 8th bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar9Click</td>
<td>Function that is executed when the 9th bar is clicked on.</td>
<td>Function</td>
</tr>
<tr>
<td>zenonBar10Click</td>
<td>Function that is executed when the 10th bar is clicked on.</td>
<td>Function</td>
</tr>
</tbody>
</table>
### 6.5.7 Circular gauge control

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>CurrentValue</code></td>
<td>Current value which should be displayed.</td>
<td>Double</td>
</tr>
<tr>
<td><code>IsReversed</code></td>
<td>Scale orientation - clockwise or anti-clockwise.</td>
<td>Boolean</td>
</tr>
<tr>
<td><code>ElementFontFamily</code></td>
<td>Element font.</td>
<td>Font</td>
</tr>
<tr>
<td><code>MinValue</code></td>
<td>Minimum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td><code>MaxValue</code></td>
<td>Maximum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td><code>ScaleRadius</code></td>
<td>Radius of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td><code>ScaleStartAngle</code></td>
<td>Angle at which the scale starts.</td>
<td>Double</td>
</tr>
<tr>
<td><code>ScaleLabelRotationMode</code></td>
<td>Alignment of the scale caption.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td> None</td>
</tr>
<tr>
<td></td>
<td></td>
<td> Automatic</td>
</tr>
<tr>
<td></td>
<td></td>
<td> SurroundIn</td>
</tr>
<tr>
<td></td>
<td></td>
<td> SurroundOut</td>
</tr>
<tr>
<td><code>ScaleSweepAngle</code></td>
<td>Angel area which defines the size of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td><code>ScaleLabelFontSize</code></td>
<td>Font size of the scale caption.</td>
<td>Double</td>
</tr>
<tr>
<td><code>ScaleLabelColor</code></td>
<td>Font color of the scale caption.</td>
<td>Color</td>
</tr>
<tr>
<td><code>ScaleLabelRadius</code></td>
<td>Radius on which the scale caption is orientated.</td>
<td>Double</td>
</tr>
<tr>
<td><code>ScaleValuePrecision</code></td>
<td>Accuracy of the scale caption.</td>
<td>Integer</td>
</tr>
<tr>
<td><code>PointerStyle</code></td>
<td>Shape of the pointer displaying the value.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td> Arrow</td>
</tr>
<tr>
<td></td>
<td></td>
<td> Rectangle</td>
</tr>
<tr>
<td></td>
<td></td>
<td> TriangleCap</td>
</tr>
<tr>
<td></td>
<td></td>
<td> Pentagon</td>
</tr>
<tr>
<td></td>
<td></td>
<td> Triangle</td>
</tr>
<tr>
<td><code>MajorTickColor</code></td>
<td>Color of main ticks on the scale.</td>
<td>Color</td>
</tr>
<tr>
<td><code>MinorTickColor</code></td>
<td>Color of sub ticks on the scale.</td>
<td>Color</td>
</tr>
<tr>
<td><code>MajorTickSize</code></td>
<td>Size of main ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td><code>MinorTickSize</code></td>
<td>Size of sub ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td><code>MajorTicksCount</code></td>
<td>Number of main ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td><code>MajorTicksShape</code></td>
<td>Shape/type of main ticks on the scale.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td> Rectangle</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>---------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ Trapezoid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ Triangle</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>MinorTicksShape</td>
<td>Shape/type of sub ticks on the scale.</td>
<td>Enum:</td>
</tr>
</tbody>
</table>
|                              |                                                                             | - Rectangle
|                              |                                                                             | - Trapezoid
|                              |                                                                             | - Triangle |
| MinorTicksCount              | Number of sub ticks on the scale.                                           | Integer  |
| PointerSize                  | Size of the pointer.                                                        | Size     |
| PointerCapRadius             | Size of the pointer fastening point.                                        | Double   |
| PointerBorderBrush           | Color of pointer border.                                                    | Brush    |
| PointerCapStyle              | Shape/type of pointer fastening point.                                     | Enum:    |
|                              |                                                                             | - BackCap
|                              |                                                                             | - FrontCap
<p>|                              |                                                                             | - Screw  |
| PointerCapBorderBrush        | Color of pointer fastening point.                                          | Brush    |
| PointerColorBrush            | Color of pointer.                                                           | Brush    |
| GaugeBorderColor             | Color of the element border.                                                | Brush    |
| GaugeBackgroundColor         | Color of element background.                                                | Brush    |
| PointerCapColorBrush         | Color of pointer fastening point.                                          | Brush    |
| GaugeMiddlePlate             | Radius of the element background middle plate.                              | Double   |
| PointerOffset                | Offset of the pointer (displacement).                                       | Double   |
| RangeRadius                  | Radius of the total range display.                                         | Double   |
| RangeThickness               | Thickness of the total range display.                                       | Double   |
| RangeStartValue              | Start value of the total range display.                                     | Double   |
| Range1EndValue               | End value of the 1st area and start value of the 2nd range.                 | Double   |
| Range2EndValue               | End value of the 2nd area and start value of the 3rd range.                 | Double   |
| Range3EndValue               | End value of the 3rd area and start value of the 4th range.                 | Double   |
| Range4EndValue               | End value of the 4th area and start value of the 5th range.                 | Double   |
| Range5EndValue               | End value of the 5th area and start value of the 6th range.                 | Double   |
| Range6EndValue               | End value of the 6th range.                                                 | Double   |
| Range1ColorBrush             | Color of the first range.                                                   | Brush    |
| Range2ColorBrush             | Color of the second range.                                                  | Brush    |
| Range3ColorBrush             | Color of the third range.                                                   | Brush    |
| Range4ColorBrush             | Color of the fourth range.                                                  | Brush    |
| Range5ColorBrush             | Color of element fifth range.                                               | Brush    |
| Range6ColorBrush             | Color of element sixth range.                                               | Brush    |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ScaleOuterBorderBrush</td>
<td>Color of the scale border.</td>
<td>Brush</td>
</tr>
<tr>
<td>ScaleBackgroundBrush</td>
<td>Color of scale background.</td>
<td>Brush</td>
</tr>
<tr>
<td>ValueTextFrameStyle</td>
<td>Shape/type of value display.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LargeFrame</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SmallFrame</td>
</tr>
<tr>
<td></td>
<td></td>
<td>None</td>
</tr>
<tr>
<td>ValueTextContent</td>
<td>Content of the value display.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Text</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TextValue</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Value</td>
</tr>
<tr>
<td>ValueTextSize</td>
<td>Font size of the value display.</td>
<td>Double</td>
</tr>
<tr>
<td>ValueTextColor</td>
<td>Font size of the value display.</td>
<td>Color</td>
</tr>
<tr>
<td>IsGlasReflection</td>
<td>Activate the glass effect on the element.</td>
<td>Boolean</td>
</tr>
<tr>
<td>GaugeOffsett</td>
<td>Lowering the rotation point of the whole element.</td>
<td>Double</td>
</tr>
</tbody>
</table>

### 6.5.8 Sankey diagram

The Sankey diagram, WPF element is available to partners of COPA-DATA and is available to these via the Partner Portal.

The Sankey wizard must be used to model a Sankey diagram. The wizard creates an XML file that is then evaluated by the WPF element. To do this, the zSankeyName property must be given the name of the XML file. The XML file must be in the Other folder of a project. This is saved there by the wizard.

An example of a Sankey diagram in Runtime is shown below:

The following settings can be made in the WPF configuration window under COPADATA-ELEMENT:
<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>FontSize</td>
<td>Font size of the texts.</td>
<td>Integer</td>
</tr>
<tr>
<td>zBackgroundColor</td>
<td>Background color of the diagram.</td>
<td>Color (String)</td>
</tr>
<tr>
<td>zFontColor</td>
<td>Color of the texts.</td>
<td>Color (String)</td>
</tr>
<tr>
<td>zFontFamily</td>
<td>Font of all texts.</td>
<td>Font (String)</td>
</tr>
<tr>
<td>zLossDetectionActive</td>
<td>Automatic loss detection activated/deactivated. If true, then losses are automatically shown at a node points as flows.</td>
<td>Boolean</td>
</tr>
<tr>
<td>zNoDataText</td>
<td>Text that is displayed if there are no values to display and zPreviewActive is false.</td>
<td>String</td>
</tr>
<tr>
<td>zNoValidXMLText</td>
<td>Text that is displayed if no valid XML file with entered name has been found and zPreviewActive is false.</td>
<td>String</td>
</tr>
<tr>
<td>zNumberOfDecimalPlaces</td>
<td>Denotes how many decimal places are to be displayed.</td>
<td>Integer</td>
</tr>
<tr>
<td>zPreviewActive</td>
<td>Display of a preview activated/deactivated.</td>
<td>Boolean</td>
</tr>
<tr>
<td></td>
<td>The preview can be displayed if</td>
<td></td>
</tr>
<tr>
<td></td>
<td>There is no data present (the modeled diagram is filled with default values) or</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the XML file was not found or</td>
<td></td>
</tr>
<tr>
<td></td>
<td>this does not contain a valid definition (an example Sankey diagram is displayed).</td>
<td></td>
</tr>
<tr>
<td>zRefreshRate</td>
<td>Rate at which the diagram is refreshed in ms.</td>
<td>Integer</td>
</tr>
<tr>
<td>zSankeyName</td>
<td>Name of the XML file with the modeling of the diagram.</td>
<td>String</td>
</tr>
<tr>
<td>zShowRelativeValues</td>
<td>Display of the values in absolute false or relative values true.</td>
<td>Boolean</td>
</tr>
</tbody>
</table>

**Note:** Additional VSTA programming is necessary for the display of the Sankey class diagram in the zenon web client. You can find details on this in the display of WPF elements in the zenon web client (on page 90).
### 6.5.9 Temperature indicator - TemperatureIndicatorControl

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CurrentValue</td>
<td>Current value which should be displayed.</td>
<td>Double</td>
</tr>
<tr>
<td>MinValue</td>
<td>Minimum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>MaxValue</td>
<td>Maximum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>MajorTicksCount</td>
<td>Number of main ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td>MinorTicksCount</td>
<td>Number of sub ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td>TickNegativColor</td>
<td>Color of the negative main tick (gradient to TickPositivColor).</td>
<td>Color</td>
</tr>
<tr>
<td>TickPositivColor</td>
<td>Color of the positive main tick (gradient to TickNegativColor).</td>
<td>Color</td>
</tr>
<tr>
<td>MinorTickColor</td>
<td>Color of the sub ticks.</td>
<td>Color</td>
</tr>
<tr>
<td>ElementBorderBrush</td>
<td>Color of the element border.</td>
<td>Brush</td>
</tr>
<tr>
<td>ElementBackgroundBrush</td>
<td>Color of element background.</td>
<td>Brush</td>
</tr>
<tr>
<td>ElementGlasReflection</td>
<td>Activate the glass effect on the element.</td>
<td>Visibility</td>
</tr>
<tr>
<td>ElementFontFamily</td>
<td>Element font.</td>
<td>Font</td>
</tr>
<tr>
<td>IndicatorColor</td>
<td>Color of the indicator fill color.</td>
<td>Color</td>
</tr>
<tr>
<td>IndicatorBorderColor</td>
<td>Color of the indicator border.</td>
<td>Color</td>
</tr>
<tr>
<td>MajorTickSize</td>
<td>Size of main ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td>MinorTickSize</td>
<td>Size of sub ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td>ScaleLetteringDistance</td>
<td>Distance of the scale caption (vertical), each x. main tick should be captioned.</td>
<td>Integer</td>
</tr>
<tr>
<td>IndicatorScaleDistance</td>
<td>Distance between indicator and scale (horizontal).</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleFontSize</td>
<td>Font size of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleFontColor</td>
<td>Font color of the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>Unit</td>
<td>Unit.</td>
<td>String</td>
</tr>
<tr>
<td>ElementStyle</td>
<td>Shape/type of element.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td>▶ SmallFrame</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ Unit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ None</td>
<td></td>
</tr>
</tbody>
</table>
## 6.5.10 Universal slider - UniversalReglerControl

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CurrentValue</strong></td>
<td>Current value which should be displayed.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>ElementFontFamily</strong></td>
<td>Element font.</td>
<td>Font</td>
</tr>
<tr>
<td><strong>MinValue</strong></td>
<td>Minimum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>MaxValue</strong></td>
<td>Maximum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>Radius</strong></td>
<td></td>
<td>Double</td>
</tr>
<tr>
<td><strong>ScaleRadius</strong></td>
<td>Radius of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>ScaleStartAngle</strong></td>
<td>Angle at which the scale starts.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>ScaleLabelRotationMode</strong></td>
<td>Alignment of the scale caption.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Automatic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SurroundIn</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SurroundOut</td>
</tr>
<tr>
<td><strong>ScaleSweepAngle</strong></td>
<td>Angel area which defines the size of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>ScaleLabelFontSize</strong></td>
<td>Font size of the scale caption.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>ScaleLabelColor</strong></td>
<td>Font color of the scale caption.</td>
<td>Color</td>
</tr>
<tr>
<td><strong>ScaleLabelRadius</strong></td>
<td>Radius on which the scale caption is orientated.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>ScaleValuePrecision</strong></td>
<td>Accuracy of the scale caption.</td>
<td>Integer</td>
</tr>
<tr>
<td><strong>ElementStyle</strong></td>
<td>Display type of the element</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Knob</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Plate</td>
</tr>
<tr>
<td></td>
<td></td>
<td>None</td>
</tr>
<tr>
<td><strong>MajorTickColor</strong></td>
<td>Color of main ticks on the scale.</td>
<td>Color</td>
</tr>
<tr>
<td><strong>MinorTickColor</strong></td>
<td>Color of sub ticks on the scale.</td>
<td>Color</td>
</tr>
<tr>
<td><strong>MajorTickSize</strong></td>
<td>Size of main ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td><strong>MinorTickSize</strong></td>
<td>Size of sub ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td><strong>MajorTicksCount</strong></td>
<td>Number of main ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td><strong>MajorTicksShape</strong></td>
<td>Shape/type of main ticks on the scale.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Rectangle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Trapezoid</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Triangle</td>
</tr>
</tbody>
</table>
6.5.11 Waterfall diagram

The waterfall diagram, WPF element is available to partners of COPA-DATA and is available to these via the Partner Portal.

The meaning and waterfall chart wizard must be used to model a waterfall diagram. A waterfall can be modeled with this wizard. The information is saved directly for the variables concerned in the Analyzer --> Parameters for waterfall diagram.
An example of a waterfall diagram in Runtime is shown below:

![Waterfall Diagram Example](image)

**Note:** This screenshot is only available in English.

The following settings can be made in the WPF configuration window under COPADATA-ELEMENT:

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>zenonRefreshRate</td>
<td>Time between the refreshes of the diagram in ms.</td>
<td>Integer</td>
</tr>
<tr>
<td>zenonWaterfallIdentifier</td>
<td>Name of the waterfall diagram.</td>
<td>String</td>
</tr>
<tr>
<td>zenonZSystemModel</td>
<td>Equipment group of the variables used.</td>
<td>String</td>
</tr>
</tbody>
</table>

**Note:** Additional VSTA programming is necessary for the display of the waterfall diagram in the zenon web client. You can find details on this in the display of WPF elements in the zenon web client (on page 90).

### 6.6 Display of WPF elements in the zenon web client

In order to also be able to also use the pre-made WPF elements "energy class diagram", "Sankey diagram" and "waterfall chart" for the display in a zenon web client, amendments are necessary in the project:

- Engineering in the zenon Editor (on page 91)
- Adapt VSTA code (on page 91)
6.6.1 Engineering in the zenon Editor

Carry out the following project configuration steps in the zenon Editor, in order to also be able to display certain WPF elements in the zenon web client:

PLACE WPF IN THE ZENON SCREEN:

- Place the WPF element in a zenon screen.
- Give it a unique name in the Element name property.
  You can find this property in the General properties group.
  **Note:** A warning dialog appears if the name for an element has already been issued in another screen.
- Use the element name issued here in the VSTA code.

6.6.2 VSTA code (complex)

In order to add the programmer code for the display of WPF elements in the zenon web client, carry out the following steps:

1. In the zenon Editor, switch to the programmer interfaces node.
2. Select the VSTA node and select the Open VSTA Editor with project add-in... with a right mouse click
3. The dialog to create a VSTA project is opened.
4. Select the C# entry in the Create new VSTA project dialog.
5. Create (copy) the code below.
6. Enter the name of the WPF element in the code.

**Note:** When opening the VSTA editor, note whether the content of the following code is already present in the project configuration. For the display of the WPF element in the web client, compare the existing code and undertake the necessary additions. Please note the comments in relation to this in the model code.

**VSTA CODE**

```
//As member:
zenOn.IDynPictures zScreens = null;
```
string[] WPFEElements = {"WPF_Control", "WPFWebclient_1", "WPFWebclient_2"}; //Names of the WPF screen elements that appear in the zenon project and that need access to the API (as many/few as you want)

//Add the following three lines of code in the project archive function:
void ThisProject_Active()
{
    zScreens = this.DynPictures();
    zScreens.Open += new zenOn.DDynPicturesEvents_OpenEventHandler(zScreens_Open);
    zScreens.Close += new zenOn.DDynPicturesEvents_CloseEventHandler(zScreens_Close);
}

//Add the following two lines of code in the project inactive function:
void ThisProject_Inactive()
{
    zScreens.Open -= new zenOn.DDynPicturesEvents_OpenEventHandler(zScreens_Open);
    zScreens.Close -= new zenOn.DDynPicturesEvents_CloseEventHandler(zScreens_Close);
}

//Final release and garbage collection of any API-Objects.
FreeObjects();
}

//Add two new event handlers:
void zScreens_Open(zenOn.IDynPicture obDynPicture)
{
    foreach (string element in WPFEElements)
    {
        if (obDynPicture.Elements().Item(element) != null)
        {
            obDynPicture.Elements().Item(element).set_WPFProperty("ELEMENT", "zenonVariableLink", this.Variables().Item(0));
        }
    }
}

void zScreens_Close(zenOn.IDynPicture obDynPicture)
{
    foreach (string element in WPFElements)
    {
        if (obDynPicture.Elements().Item(element) != null)
        {
            
        }
    }
}
zenOn.IElement zWPFElem = obDynPicture.Elements().Item(element);
zWPFElem.set_WPFProperty("ELEMENT", "zenonTrigger", true);
zWPFElem = null;

6.6.3 VSTA code (simplified)

If only one WPF element is used in a zenon screen, the following more streamlined code can be used as an alternative. To do this, the names of the WPF element, and the screen in which the element is used, must be entered. This code is then recommended if, for each project, only one of the pre-made WPF elements is used.

VSTA CODE
zenOn.IDynPicture zScreen = zero;
string wpfElement = "WPF_Control"; //Name of the WPF element in the screen
string wpfPicture = "@Details_Overview_Online"; //Name of the zenon screen

//Add to the project active function:
void ThisProject_Active()
{
    zScreen = this.DynPictures().Item(wpfPicture);
    zScreen.Open += new zenOn.OpenEventHandler(zScreen_Open);
    zScreen.Close += new zenOn.CloseEventHandler(zScreen_Close);
}

//Add to the project inactive function:
void ThisProject_Inactive()
{
    zScreen.Open -= new zenOn.OpenEventHandler(zScreen_Open);
    zScreen.Close -= new zenOn.CloseEventHandler(zScreen_Close);

    //Final release and garbage collection of any API-Objects.
    FreeObjects();
}
void zScreen_Open()
{
    if (zScreen.Elements().Item(wpfElement) != null)
    {
        zScreen.Elements().Item(wpfElement).set_WPFProperty("ELEMENT",
        "zenonVariableLink", this.Variables().Item(0));
    }
}

void zScreen_Close()
{
    if (zScreen.Elements().Item(wpfElement) != null)
    {
        zenOn.IElement zWPFElement = zScreen.Elements().Item(wpfElement);
        zWPFElement.set_WPFProperty("ELEMENT", "zenonTrigger", true);
        zWPFElement = null;
    }
}

6.7 Examples: Integration of WPF in zenon

You can see how XAML files are created and integrated as WPF elements in zenon from the following examples:

- Integrate button as WPF XAML in zenon (on page 100)
- Integrate bar graph as WPF XAML in zenon (on page 94)
- Integrate DataGrid Control in zenon (on page 106)

6.7.1 Integrate bar graph as WPF XAML in zenon

Example structure:

- Creating a bar graph (on page 15) in Adobe Illustrator and converting it to WPF
- Integrate into zenon
- Linking with variables
Adapting the bar graph WPF element

CREATE BAR GRAPH

The first step is to generate a bar graph as described in the Workflow with Adobe Illustrator (on page 15) chapter. To be able to use the XAML file in zenon, insert this in the project tree in the Files/graphics folder.

INTEGRATE BAR GRAPH

Note: A zenon project with the following content is used for the following description:

- An empty screen as a start screen
- Four variables from the internal driver for
  - Scale 0
  - Scale central
  - Scale high
  - Current value
- A variable from the mathematics driver for displaying the current value (255)

To integrate the bar graph:

1. open the empty screen
2. place a WPF element (on page 48) in the screen
3. select XAML file in the properties window
4. Select the desired XAML file (for example bar_graph_vertical.xaml) and close the dialog
ADJUST BAR GRAPH

Before configuration, the scale of the XAML file is adapted if necessary:

To do this:

- Create a new mathematics variable that calculates the new value in relation to the scaling, for example:
- Variable: 0-1000
• Mathematic variable \( \text{value created in xaml file}} \times \text{Variable/1000} \)

The XAML file is then configured.

**CONFIGURE BAR GRAPH**

1. Click on the WPF element and select the **Configuration** property
2. The configuration dialog shows a preview of the selected XAML file.
3. Select the minimum value, the average value and the maximum value and link each of these to the corresponding variable in the **Content** property.
4. Select the **Slider** and link the **Value** property to the mathematics variables (in our example: calculation).

5. Check the project planning in Runtime:
6.7.2 Integrate button as WPF XAML in zenon

Example structure:
- Creating a button (on page 11) in Microsoft Expression Blend
- Integrate into zenon
- Link to a variable and a function
- adjust the button to the size of the element
- Create button

As a first step, create a button as described in the Create button as XAML file with Microsoft Expression Blend (on page 11) chapter. To be able to use the XAML file in zenon, insert this in the project tree in the Files/graphics folder.

INTEGRATE BUTTON

Note: A zenon project with the following content is used for the following description:
- An empty screen as a start screen
- an internal variable int of type Int
- a function Funktion_0 of type Send value to hardware with:
  - Direct to hardware option activated
  - Set was set to 45

To integrate the button:
1. open the empty screen
2. place a WPF element (on page 48) in the screen
3. select XAML file in the properties window
4. select the XAML file (e.g. MyButton.xaml) and close the dialog
5. select the Configuration property
CONFIGURE THE BUTTON

The configuration dialog shows a preview of the selected XAML file. All elements named in the XAML file are listed in the tree:

1. select the WPF button, which is in LayoutRoot->MyViewBox->MyButton
2. Look in the Properties Entry Content tab; this contains the button’s text
3. Click the Link type column
4. Select Variable from the drop down list
5. Click in the Link column
6. the variable selection dialog is opened
7. select the int variable to link this variable with the Content property

EVENTS

To also assign events:
1. select the events tab

2. look for the ‘Click’ entry, this event is triggered by the WPF element, as soon as the button is clicked

3. Click in the Link type column

4. Select Function from the drop down list

5. Click in the Link column

6. the function selection dialog is opened

7. select Function_0

8. Confirm the changes with OK

9. Insert a numerical value element into the screen

10. Link this numerical value element to the int variables too.

11. Compile the Runtime files and start Runtime.
The **WPF element** is displayed in Runtime, the button text is 0. As soon as you click on the button, the **click** event is triggered and the **set value** function is carried out. The value 45 is sent directly to the hardware and both **numerical value** and **button** display the value 45.

Define a set value of 30 via the **numerical value element**; this value is then also assumed by the **WPF element**.

**AUTHORIZATION**

Similar to a **numerical value**, a **WPF element** can be locked according to authorizations (lock symbol) or switched to be operable. Set the user authorization level to 1 for the **WPF element** and create a user called **Test** with **authorization level 1**. In addition, set up the functions **Login with dialog** and **Logout**. You link these two functions with 2 new text buttons on the screen.

In the **WPF element** configuration dialog, select the **MyButton WPF button** and select the **Properties**: tab
1. Select the **isEnabled** element
2. Click in the **Link type** column
3. Select **Authorizations/interlocking** from the drop down list
4. Click in the **Link** column
5. In the drop-down list, select the **Authorized** option

![Configuration dialog](image1)

6. Close the dialog with **OK**

Compile the Runtime file and note that Authorizations to be Transferred must also be selected. After Runtime has been started, the WPF button is displayed as deactivated on the screen and cannot be operated. If you now log in as the user **Test**, the button is activated and can be operated. The button is locked again as soon as you log out.

![Login and Logout buttons](image2)

**TRANSFORMATION**

The XAML files must still be adapted to use transformations:

1. switch to the **Expression Blend** program
2. select **MyButton**, so that the properties of the element are visible in the events window

![Transform settings](image3)

3. Under **Transform** at **RenderTransform** select the **Apply relative transform** option
As a result of this, a block is inserted into the XAML file, which save the transformation settings in runtime.

```xml
<Button,RenderTransform>
    <TransformGroup>
        <ScaleTransform ScaleX="1" ScaleY="1"/>
        <SkewTransform AngleX="0" AngleY="0"/>
        <RotateTransform Angle="0"/>
        <TranslateTransform X="0" Y="0"/>
    </TransformGroup>
</Button,RenderTransform>
```

4. Save the file and replace the old version in zenon with this new file.

5. Open the WPF element configuration dialog again:
   a) select the **MyButton** button
   b) select the **Transformations** tab
   c) select the **RotateTransform.Angle** element
   d) Click in the **Link type** column
   e) Select **Transformations** from the drop down list
   f) Click in the **Link** column
   g) the variable selection dialog is opened
   h) select the **int** variable to link this variable with the **RotateTransform.Angle** property
Compile the Runtime files and start Runtime. Log in as the Test user and click on the button. The button has the value 45 and the WPF element rotates by 45°.

6.7.3 Integrate DataGrid Control in zenon

To create DataGrid control for zenon, you need:

- Visual Studio (Visual Studio 2015 in this example)

CREATE WPF USER CONTROL

1. In Visual Studio, create a new Solution and a WPF User Control Library project in .NET Framework version 4 or higher therein.

   Info: If the corresponding project template does not appear in the list of available templates, this can be added by means of the search (field at the top right of the dialog).
In our example, the project is given the name **DataGridControlLibrary**.

2. Create a new data connection in the **Server Explorer**.

   In our example, the database **Northwind** is used, which is provided by Microsoft as an example database that can be downloaded for free.

   To set up the database connection:
   a) Right-click on **Data Connections**.
   b) Select **Add connection**....
   c) Select **Microsoft SQL Server (SQLClient)** as **Data source**.
   d) Select the corresponding server and database name.
After adding the connection, the Server Explorer window should look a little like this:

A new DataSet is created in the next step.

**CREATING A DATASET**

1. Right-click on the project
2. Select **Add – New Item...** in the context menu
3. Create a new **DataSet** with the name **DataSet1**.
4. Double click on the DataSet in order to open it in the Designer.
5. Drag the tables that you need (**Customers** and **Orders** in this example) to the DataSet design window.

The XAML file is modified in the next step.
CONFIGURATION OF THE XAML FILE

1. If not already there, add the Namespace as a reference to the class in the XAML file:

```xml
<UserControl xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
 xmlns="http://schemas.microsoft.com/winfx/2006/xaml"
 xmlns:d="http://schemas.microsoft.com/expression/blend/2008"
 xmlns:s="http://schemas.microsoft.com/winfu/2008" x:Class="classname"
 xmlns="http://schemas.microsoft.com/winfx/2006/xaml" ">

```

2. Define the resources and the DataGrid that is to be used in the WPF:

```xml
<UserControl.Resources>
    <local:DataSet1 x:Key="DataSet1"/>
    <CollectionViewSource x:Key="CustomersViewSource" Source="{Binding Path=Customers, Source={StaticResource DataSet1}}"/>
</UserControl.Resources>

<Grid DataContext="{StaticResource CustomersViewSource}">
    <DataGrid Name="DataGrid1" DisplayMemberPath="CompanyName" ItemsSource="{Binding}" SelectedValuePath="CustomerID" HorizontalAlignment="Stretch" VerticalAlignment="Stretch"/>
</Grid>
```

3. Open the code-behind file (UserControl1.xaml.cs) and insert the following lines in the constructor:

```csharp
public UserControl1()
{
    InitializeComponent();
    DataSet1 ds = ((DataSet1)(FindResource("DataSet1")));
    DataSet1TableAdapters.CustomersTableAdapter ta = new DataSet1TableAdapters.CustomersTableAdapter();
    ta.Fill(ds.Customers);
    CollectionViewSource CustomersViewSource = ((CollectionViewSource)(this.FindResource("CustomersViewSource")));
    CustomersViewSource.View.MoveCurrentToFirst();
}
```

In doing so, the following happens:

- The DataSet is obtained
- A new TableAdapter is created
- The DataSet is filled
The information is provided to the DataGrid control.

The solution can now be built.

**BUILD**

Now build the solution. The corresponding DLL (**DataGridControlLibrary.dll**) is created in the output folder of the project.

Now you have a DLL with the necessary functionality available.

However, Zenon can only display XAML files that cannot be linked to the code behind file, which is why an additional XAML file is needed that references the DLL that has just been created.

To do this:

1. Create a further project, again as a **WPF User Control Library**
2. It was called **DataGridControl** in our example.
3. Insert a reference to the project that has just been built into this new project.

4. The XAML files (**UserControl1.xaml**) looks as follows:

```xml
<UserControl x:Class="DataGridControl.UserControl1"
  xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
  xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
  xmlns:d="http://schemas.microsoft.com/expression/blend/2008"
  mc:Ignorable="d"
  d:DesignHeight="300" d:DesignWidth="300">
  <Grid>
    <!-- Content goes here -->
  </Grid>
</UserControl>
```

5. Because all necessary content is contained in the DLL that has been created and no code-behind is necessary, delete the following lines:

```xml
x:Class="DataGridControl.UserControl1"
xmlns:local="clr-namespace:DataGridControl"
```

6. Also delete (for the positioning) the following lines:

```xml
mc:Ignorable="d"
d:DesignHeight="300" d:DesignWidth="300"
```
7. Delete the code-behind file (UserControl1.xaml.cs) in this project.

8. Define what is to be displayed in the XAML file.

   To do this, modify the XAML file as follows:

   ```xml
   <UserControl xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
                 xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
                 xmlns:d="http://schemas.microsoft.com/expression/blend/2008"
                 xmlns:dataGridLibrary="clr-namepace:DataGridControlLibrary;assembly=DataGridControlLibrary">
     <Grid x:Name="Grid1">
       <dataGridLibrary:UserControl1 Name="DataGridControl" HorizontalAlignment="Left"
                                      VerticalAlignment="Top"/>
     </Grid>
   </UserControl>
   
   The line xmlns:dataGridLibrary="clr-namepsace:DataGridControlLibrary;assembly=DataGridControlLibrary" defines the namespace dataGridLibrary and stipulates that this should use the assembly that has been created.

9. Assign a name for the grid.

10. Insert the control dataGridLibrary:UserControl1 from our library and give it a name, because zenon can only modify objects that have a name.

11. Build the solution.

In the next step, how the DLL and XAML file are added to zenon is explained.

**STEPS IN ZENON**

1. Open the zenon Editor

2. Go to File -> Graphics.
3. Select **Add file...** in the context menu

![Add file context menu](image)

4. Select the XAML file at the save location (**UserControl1.xaml** from the **DataGridControl** project) and add this:

![XAML file selection](image)

5. Insert the DLL with the functionality for the XAML file.
   To do this:
   a) Select, in the context menu, File -> Other **Add file...**
   b) Select the file **DataGridControlLibrary.dll** of the first project (**DataGridControlLibrary**).

![DLL file selection](image)

6. Create a zenon screen.

7. Add a WPF element and select the previously-incorporated XAML file.
   You should now see the following in the zenon Editor:

![Zenon Editor with WPF element](image)

8. Start zenon Runtime in order to also test the control there.
Attention

Assemblies are only removed after loading when the application is ended. This means:

If a WPF file with a referenced assembly in zenon is displayed, then this assembly is loaded is in the memory until zenon is ended, even if the screen is closed again. If you would like to remove an assembly from the Files/Other folder, the Editor must first be restarted, so that the assembly is removed.

6.8 Error handling

ENTRIES IN LOG FILES

<table>
<thead>
<tr>
<th>Entry</th>
<th>Level</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Xaml file found in %s with different name, using default!</td>
<td>Warning</td>
<td>The name of the collective file and the name of the XAML file contained therein do not correspond. To avoid internal conflicts, the file with the name of the collective file and the suffix .xaml is used.</td>
</tr>
<tr>
<td>no preview image found in %s</td>
<td>Warning</td>
<td>The collective file does not contain a valid preview graphic (preview.png or [names of the XAML file].png). Thus no preview can be displayed.</td>
</tr>
<tr>
<td>Xaml file in %s not found or not unique!</td>
<td>Error</td>
<td>The collective file does not contain an XAML file or several files with the suffix .xaml. It cannot be used.</td>
</tr>
<tr>
<td>Could not remove old assembly %s</td>
<td>Warning</td>
<td>There is an assembly that is to be replaced with a newer version, but cannot be deleted.</td>
</tr>
<tr>
<td>Could not copy new assembly %s</td>
<td>Error</td>
<td>A new version is available for an assembly in the work folder, but it cannot be copied there. Possible reason: The old example is still loaded, for example. The old version continues to be used, the new version cannot be used,</td>
</tr>
<tr>
<td>file exception in %s</td>
<td>Error</td>
<td>A file error occurred when accessing a collective file.</td>
</tr>
<tr>
<td>Generic exception in %s</td>
<td>Error</td>
<td>A general error occurred when accessing a collective file.</td>
</tr>
</tbody>
</table>